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About This Guide

This ZENworks 11 SP3 Server Installation Guide includes information to help you successfully install 
the ZENworks Primary Server software on Windows and Linux servers. 

The information in this guide is organized as follows:

 Part I, “System Requirements,” on page 9

 Part II, “Windows Installation,” on page 19

 Part III, “Linux Installation,” on page 63

 Part IV, “Appendixes,” on page 105

Audience

This guide is intended for ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation.

Additional Documentation

ZENworks 11 SP3 is supported by other documentation (in both PDF and HTML formats) that you 
can use to learn about and implement the product. For additional documentation, see the ZENworks 
11 SP3 documentation web site (http://www.novell.com/documentation/zenworks113).
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I ISystem Requirements

The following section provides the system requirements for installing a ZENworks Primary Server: 

 Chapter 1, “Primary Server Requirements,” on page 11

 Chapter 2, “Database Requirements,” on page 15

 Chapter 3, “Administration Browser Requirements,” on page 17
System Requirements 9
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1 1Primary Server Requirements

The server where you install the Primary Server software must meet the following requirements:

Item Requirements Additional Details

Server 
Usage

Your server might be capable of handling tasks in 
addition to the tasks that a Primary Server 
performs. However, we recommend that any server 
where you install the Primary Server software be 
used only for ZENworks.

For example, you might not want the server 
to do the following:

 Host Novell eDirectory

 Host Active Directory

 Host Terminal Services

Operating 
System 
Windows

 Windows Server 2003 SP2 x86_64 
(Enterprise and Standard editions)

 Windows Server 2003 R2 SP2 x86_64 
(Enterprise and Standard editions)

 Windows Server 2008 SP2 x86_64 
(Enterprise and Standard editions)

 Windows Server 2008 R2 x86_64 (Enterprise 
and Standard editions)

 Windows Server 2008 R2 SP1 x86_64 
(Enterprise and Standard editions)

 Windows Server 2008 R2 x86_64 (Datacenter 
edition)

 Windows 2012 Server x86_64 (Foundation, 
Essential, Standard, and Datacenter editions)

 Windows 2012 Server R2 x86_64 
(Foundation, Essential, Standard, and 
Datacenter editions)

 New in 11.3.1: Windows 2012 Server R2 
Update 1 x86_64

All the Core and Data Center Editions of 
Windows Server 2003 and Windows Server 
2008 are not supported as Primary Server 
platforms. Windows Server 2008 Core is 
not supported because it does not support 
the.NET Framework.

ZENworks Primary Server software is 
supported on Windows Server 2003, 
Windows Server 2008, and Windows 
Server 2012 R2 editions with or without 
Hyper-V.

NOTE: Installation on a server in a 
clustered environment is not supported.

IMPORTANT

 No x86 (32-bit) operating systems are 
supported for ZENworks Primary 
Server platforms in ZENworks 11 SP3.

 If you want to install or upgrade 
ZENworks 11 SP3 in Windows Server 
2008 R2 Datacenter, then perform the 
steps mentioned in TID 7015680.

Operating 
System 
Linux

 SLES 11 SP2/SP3 x86_64 (Intel and AMD 
Opteron processors)

 SLES 11 SP2 and SP3 for VMware X86_64

 Red Hat Enterprise Linux 5.8, 5.9 x86_64

 Red Hat Enterprise Linux 6.1, 6.2, 6.3, 6.4 
x86_64 

IMPORTANT: Open Enterprise Server (32-
bit and 64-bit) operating systems are not 
supported for ZENworks Primary Server 
platforms in ZENworks 11 SP3.
Primary Server Requirements 11
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Processor Speed:2.0 GHz or faster

Type: Server-class CPU such as AMD64 dual core 
or Intel EM64T dual core or faster

If the Primary Server is running on a Virtual 
Machine, we recommend a dual-core 
processor.

If the Primary Server is running Patch 
Management, we recommend a fast 
processor, such as the Intel Quad Core 
processor.

RAM 4 GB minimum; 8 GB and above recommended 4 GB for the first 3000 devices

Add 1 GB RAM for every 3000 additional 
devices

Disk Space 9 GB for installation. Depending on the amount of 
content you need to distribute the space. 

For ZENworks database add 10 GB for every 1000 
devices and for Audit database add 10 GB for every 
5000 devices.

500 MB is recommended for the tmp directory. This 
disk space is required for rebuilding and editing the 
packages.

Patch Management file storage (downloaded patch 
content) requires at least 25 GB of additional free 
disk space. All content replication servers also 
require this same amount of additional free disk 
space if Patch Management is enabled. If you use 
Patch Management in additional languages, each 
server also requires this additional amount of free 
space for each language. 

Because the ZENworks database file and 
ZENworks content repository can each 
become very large, you might want a 
separate partition or hard drive available.

For information on changing the default 
content repository location on a Windows 
server, see “Content Repository” in the 
ZENworks 11 SP3 Primary Server and 
Satellite Reference.

For Linux servers, you might want the /
var/opt directory to be located on a large 
partition. This is where the database (if 
embedded) and content repository are 
stored.

The /etc directory requires less space.

Display 
Resolution

Video Adaptor: 256 colors

Screen Resolution: 1024 × 768 minimum

File System If you have installed embedded Sybase on your 
device, ensure that the file system of the drive 
where you have installed ZENworks Configuration 
Management supports files larger than 4 GB.

DNS 
Resolution

The servers and workstations in the Management 
Zone must use properly configured DNS to resolve 
device hostnames; otherwise, some features in 
ZENworks will not work properly. If the DNS is not 
properly configured, the servers cannot 
communicate with each other, and the workstations 
cannot communicate with the servers.

Server names must support DNS requirements, 
such as not including underscores; otherwise, 
ZENworks login fails. Acceptable characters 
include the letters a-z (uppercase and lowercase), 
numbers, and the hyphen (-).

Item Requirements Additional Details
12 ZENworks 11 SP3 Server Installation Guide

https://www.novell.com/documentation/zenworks113/pdfdoc/zen11_sys_servers/zen11_sys_servers.pdf#brwh44p
https://www.novell.com/documentation/zenworks113/pdfdoc/zen11_sys_servers/zen11_sys_servers.pdf#bookinfo
https://www.novell.com/documentation/zenworks113/pdfdoc/zen11_sys_servers/zen11_sys_servers.pdf#bookinfo


IP Address The server must have a static IP address or a 
permanently leased IP address in the case of 
DHCP configuration.

An IP address must be bound to all NICs on your 
target server.

Installation hangs if it is trying to use a NIC 
that does not have an IP address bound to 
it.

Microsoft 
.NET (Only 
for 
Windows)

The Microsoft.NET 4.0 Framework and its 
latest updates must be installed and running on the 
Windows Primary Server in order to install 
ZENworks 11 SP3.

Ensure that the full.NET 4 Framework is installed 
on the device and not the.NET 4 Client 
Profile.

On Windows Server 2003/2008, you are 
given the option to launch the .NET 
installation during ZENworks installation. If 
you select the option, .NET is automatically 
installed.

On Windows Server 2012, .NET 4.5 is 
available by default. However, you need to 
enable it. You are given the option to 
enable .NET during the ZENworks 
installation. If you select the option, .NET is 
automatically enabled. 

For more information, see “Enabling the 
.NET Framework” in the ZENworks 11 SP3 
Discovery, Deployment, and Retirement 
Reference. 

Firewall 
Settings: 
TCP and 
UDP Ports

Many TCP and UDP ports are opened by the 
ZENworks Installer during installation. If a port 
required by ZENworks is in use, the ZENworks 
Installer prompts you to configure an alternate port. 

IMPORTANT: If the firewall is disabled during 
installation or upgrade, ensure that you manually 
open the ports in the firewall settings when the 
firewall is enabled. 

For the list of TCP and UDP ports and how 
ZENworks uses them, see “TCP and UDP 
Ports Used by ZENworks Primary Servers” 
in the ZENworks 11 SP3 Primary Server 
and Satellite Reference.

Supported 
Hypervisors

Primary server software can be installed in the 
following virtual machine environments:

 VMware Workstation 6.5

 XEN (Novell SLES 11 and Citrix XenServer 
5.x, 6.0, 6.1)

 VMware ESXi 5.0.x, 5.1, and 5.5

 Microsoft Hyper-V Server Windows 2008 R2 
and 2012

 Only released versions of guest 
operating systems (VMs) are 
supported. Experimental guest 
operating systems are not supported.

 The guest operating system must 
match the operating system specified 
when creating the VM. For example, if 
during creation of the VM, the guest 
operating system is specified as 
Windows Server 2003, the actual 
guest operating system must be 
Windows Server 2003.

Item Requirements Additional Details
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2 2Database Requirements

ZENworks includes an embedded Sybase SQL Anywhere database that you can use. You can also 
use your own database, referred to as an external database. If you choose to use an external 
database, it must meet the following requirements:

Item Requirement

Database Version Microsoft SQL Server 2008 R2 (and latest SP)

Microsoft SQL Server 2008 SP2 (and latest SP)

Microsoft SQL Server 2012 (and latest SP)

Microsoft SQL Server 2014 (and latest SP)

Sybase SQL Anywhere 12 

Oracle 11.2.0.4 Standard and Enterprise Edition (with or without partitioning). For 
information about partitioning, see Oracle Enterprise with Partitioning.

Oracle 11.2.0.4 Real Application Clusters (Oracle RAC)

Database Server 
Hostname

The database server hostname must be resolvable by the Domain Name Server 
Service.

TCP Ports The server must allow Primary Server communication on the database port. For MS 
SQL, ensure that you configure static ports for the database server.

Default Ports:

 1433 for MS SQL

 2638 for Sybase SQL

 2639 for Audit Sybase DB

 1521 for Oracle

You can change the default port number if there is a conflict. However, you must 
ensure that the port is opened for the Primary Server to talk to the database. 

UDP Ports 1434 for MS SQL (if ZENworks uses named instance of the database) 

WAN Consideration Primary Servers and the ZENworks database must reside on the same network 
segment. Primary Servers cannot write across a WAN to the ZENworks database.

Default Character Set For Sybase, the UTF-8 character set is required.

For MS SQL, ZENworks does not require any specific character set. ZENworks 
supports all character sets supported by MS SQL.

For Oracle, the NLS_CHARACTERSET parameter must be set to AL32UTF8, and 
the NLS_NCHAR_CHARACTERSET parameter must be set to AL16UTF16.

Collation ZENworks is not supported with a case-sensitive instance of the MS SQL database. 
Therefore, you must ensure that the database is case insensitive before setting it 
up.
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Database User Ensure that there is no restriction for the ZENworks database user to connect to a 
remote database.

For example, if the ZENworks database user is an Active Directory user, ensure that 
the Active Directory policies allow the user to connect to a remote database.

Item Requirement
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3 3Administration Browser Requirements

Ensure the workstation or server where you run ZENworks Control Center to administer your system 
meets the following requirements:

Item Requirements

Web Browser The following web browsers are supported:

 Internet Explorer 8 (32-bit only) on Windows Vista, Windows 7, Windows 
Server 2003, Windows XP, Windows Server 2008, and Windows Server 2008 
R2

 Internet Explorer 9 (32-bit only) on Windows Vista, Windows 7, Windows 
Server 2003, Windows XP, Windows Server 2008, and Windows Server 2008 
R2

 Internet Explorer 10 (32-bit only) on Windows Vista, Windows 7, Windows 
Server 2003, Windows XP, Windows Server 2008, Windows Server 2008 R2, 
Windows 8, and Windows Server 2012

IMPORTANT: 

 Internet Explorer versions prior to version 8 are not supported.

 New in 11.3.1: Internet Explorer 11 on Windows 7, Windows Server 2003, 
Windows XP, Windows Server 2008, Windows Server 2008 R2, Windows 8, 
Windows 8.1 Update 1, Windows Server 2012, and Windows Server 2012 R2 
Update 1

 Firefox ESR version 17.0, 24.0, and 31.0

 Firefox version 26.0 and 27.0 (including any patches) on Windows and Linux 
devices

 New in 11.3.1: Firefox version 28.0, 29.0, and 30(including any patches) on 
Windows and Linux devices

 New in 11.3.2: Firefox version 31.0 and 32.0 (including any patches) on 
Windows and Linux devices

TCP Ports To fulfill a user’s request for a remote session on a managed device, you must open 
port 5550 on the device, in order to run Remote Management Listener. 
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II IIWindows Installation

The following sections provide information and instructions to help you install the ZENworks Primary 
Server software on a Windows server:

 Chapter 4, “Windows Installation Workflow,” on page 21

 Chapter 5, “Understanding What the ZENworks Installation Does,” on page 25

 Chapter 6, “Updating Windows Server Software,” on page 27

 Chapter 7, “Creating an External Certificate,” on page 29

 Chapter 8, “Installing an External ZENworks Database,” on page 33

 Chapter 9, “Installing a ZENworks Primary Server on Windows,” on page 45

 Chapter 10, “Completing Post-Installation Tasks,” on page 57
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4 4Windows Installation Workflow

The tasks you must complete to install your first ZENworks Primary Server are different from the 
tasks required for additional Primary Servers. The following sections provide the workflows for both 
processes: 

 Section 4.1, “Installation Workflow for Your First Primary Server,” on page 21

 Section 4.2, “Installation Workflow for Additional Primary Servers,” on page 23

4.1 Installation Workflow for Your First Primary Server
To install the first ZENworks Primary Server and create your ZENworks Management Zone, complete 
the tasks in the order listed below.

To add a Primary Server to an existing ZENworks Management Zone, see Section 4.2, “Installation 
Workflow for Additional Primary Servers,” on page 23.

Task Details

 Review what the ZENworks installation program 
does when installing the first Primary Server and 
Management Zone. 

When installing the first Primary Server, the 
installation program performs operations to install 
the Primary Server software, set up the ZENworks 
databases, and establish the Management Zone.

For more information, see Chapter 5, 
“Understanding What the ZENworks Installation 
Does,” on page 25.

 Burn the ZENworks ISO image to a DVD to create 
an installation DVD.

You cannot extract the ISO image and use it to 
install. The installation must be run from an 
installation DVD.

 Update the software on the Windows server where 
you will install the ZENworks Primary Server.

Ensure that the Windows server software is up to 
date and that any software, such as anti-virus 
software, that might interfere with the Primary 
Server installation is updated and configured 
correctly.

For more information, see Chapter 6, “Updating 
Windows Server Software,” on page 27.
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 Create an external certificate for your Primary 
Server.

ZENworks Primary Servers communicate with 
ZENworks managed devices using the HTTPS 
protocol. This secure communication requires that 
the ZENworks Management Zone has a defined 
Certificate Authority (CA) and that each Primary 
Server has its own server certificate issued by the 
zone's CA.

ZENworks includes an internal ZENworks CA. If 
you use the internal ZENworks CA, it is created 
during installation of the first Primary Server, and 
each subsequent Primary Server you install is 
issued a certificate signed by the ZENworks CA.

Novell recommends you use the internal ZENworks 
CA unless your corporate security policies do not 
allow you to do so. The internal ZENworks CA lasts 
10 years and simplifies use of various ZENworks 
features, such as Remote Management.

If you cannot use the internal ZENworks CA, you 
can use an external CA and provide external server 
certificates for each Primary Server you install.

If you want to use external certificates, see 
Chapter 7, “Creating an External Certificate,” on 
page 29.

 Install external database software to use for the 
ZENworks databases.

ZENworks requires two databases, one for general 
data and another for audit data. For these 
databases, you can use the embedded Sybase 
database software provided with ZENworks, or you 
can use supported external database software (see 
Chapter 2, “Database Requirements,” on page 15).

 If you want to use an external database, see 
Chapter 8, “Installing an External ZENworks 
Database,” on page 33.

 Install external database software to use for the 
Audit databases.

You can use the embedded Sybase database 
software provided with ZENworks, or you can use 
supported external database software (see 
Chapter 2, “Database Requirements,” on page 15).

 If you want to use an external database, see 
Chapter 8, “Installing an External ZENworks 
Database,” on page 33.

After configuring the ZENworks database, configure 
the Audit database. The fields for ZENworks and 
Audit are same. 

 Install the ZENworks Primary Server software on a 
supported Windows server.

For instructions, see Section 9.1, “Installing the 
Primary Server Software,” on page 45.

Task Details
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4.2 Installation Workflow for Additional Primary 
Servers
To install a ZENworks Primary Server and add it to your existing ZENworks Management Zone, 
complete the tasks in the order listed below.

 Verify that the Primary Server is running. There are specific checks you can perform to 
ensure that installation of the software was 
successful and that the Primary Server is running.

For instructions, see Section 9.3, “Verifying the 
Installation,” on page 48.

 Activate the ZENworks products for which you are 
licensed or that you want to evaluate.

All ZENworks products are installed. However, you 
need to provide the license keys for the products 
that you have licensed. If desired, you can also 
activate unlicensed products for a 60-day 
evaluation period.

For instructions, see Section 10.1, “Licensing 
Products,” on page 57.

 Back up the ZENworks Primary Server and other 
ZENworks components.

You should back up the Primary Server at least one 
time and schedule regular back ups of the 
ZENworks databases.

For instructions, see Section 10.5, “Backing Up 
ZENworks Components,” on page 59.

 Review the post-installation tasks and complete any 
that apply to your Primary Server installation.

There are several post-installation tasks that you 
might need to perform for your Primary Server. 
Review the list of tasks and complete any that 
apply.

For instructions, see Chapter 10, “Completing Post-
Installation Tasks,” on page 57.

Task Details

Task Details

 Review what the ZENworks installation program 
does when adding a Primary Server to an existing 
Management Zone. 

When installing an additional Primary Server in a 
Management Zone, the installation program 
performs operations to install the Primary Server 
software, add the Primary Server to the existing 
Management Zone, install ZENworks Control 
Center, and start the ZENworks services.

For more information, see Chapter 5, 
“Understanding What the ZENworks Installation 
Does,” on page 25.

 Burn the ZENworks ISO image to a DVD to create 
an installation DVD.

You cannot extract the ISO image and use it to 
install. The installation must be run from an 
installation DVD.
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 Update the software on the Windows server where 
you will install the ZENworks Primary Server.

Ensure that the Windows server software is up to 
date and that any software, such as anti-virus 
software, that might interfere with the Primary 
Server installation is updated and configured 
correctly.

For more information, see Chapter 6, “Updating 
Windows Server Software,” on page 27.

 Create an external certificate for your Primary 
Server.

If your ZENworks Management Zone is using the 
internal ZENworks Certificate Authority (CA), the 
new Primary Server is automatically issued a server 
certificate during installation. 

If your zone is using an external CA, you must 
provide the new Primary Server with a valid 
certificate issued from the external CA.

For instructions about creating a certificate from an 
external CA, see Chapter 7, “Creating an External 
Certificate,” on page 29.

 Install the ZENworks Primary Server software on a 
supported Windows server.

Installation of an additional Primary Server is less 
complex than installation of the first Primary Server. 
The installation program only requires you to 
provide a target location for the software files, 
authentication information for the Management 
Zone (Primary Server address and Administrator 
login credentials), and files for the external 
certificate (if the zone is using an external CA).

For instructions about running the installation 
program, see Section 9.1, “Installing the Primary 
Server Software,” on page 45.

 Verify that the Primary Server is running. There are specific checks you can perform to 
ensure that installation of the software was 
successful and that the Primary Server is running.

For instructions, see Section 9.3, “Verifying the 
Installation,” on page 48.

 Back up the ZENworks Primary Server. You should back up the Primary Server at least one 
time.

For instructions, see Section 10.5, “Backing Up 
ZENworks Components,” on page 59.

 Review the post-installation tasks and complete any 
that apply to your Primary Server installation.

There are several post-installation tasks that you 
might need to perform for your Primary Server. 
Review the list of tasks and complete any that 
apply.

For instructions, see Chapter 10, “Completing Post-
Installation Tasks,” on page 57.

Task Details
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5 5Understanding What the ZENworks 
Installation Does

The ZENworks installation program does the following during installation of your first Primary Server:

 Creates the Management Zone

 Creates a password that you supply for the default ZENworks Administrator account

 Establishes and populates the ZENworks database and Audit database

The ZENworks installation program does the following during installation of any Primary Server:

 Installs the ZENworks Adaptive Agent so that the server can be managed

 Installs ZENworks Control Center, the web console used to manage your ZENworks System 

 Installs the zman command line utility

 Installs and starts the ZENworks services
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6 6Updating Windows Server Software

Before installing ZENworks Primary Server software to a Windows server, ensure that you update the 
software on the server:

 Run Windows Update on the server to ensure that all available updates are installed. When 
finished, disable Windows Update to prevent failure of the Primary Server software installation 
due to parallel installation of updates.

 Update other software (for example, anti-virus) to prevent failure of the Primary Server software 
installation due to parallel installation of updates.

 If you are testing or reviewing ZENworks 11 SP3, we recommend that you deploy the product in 
a non-production environment.
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7 7Creating an External Certificate

ZENworks Primary Servers communicate with ZENworks managed devices using the HTTPS 
protocol. This secure communication requires that the ZENworks Management Zone have a defined 
Certificate Authority (CA) and that each Primary Server have its own server certificate issued by the 
zone's CA.

ZENworks includes an internal ZENworks CA. If you use the internal ZENworks CA, it is created 
during installation of the first Primary Server. Each subsequent Primary Server you install is issued a 
certificate signed by the ZENworks CA.

We recommend that you use the internal ZENworks CA unless your corporate security policies do not 
allow you to do so. The internal ZENworks CA lasts 10 years and simplifies use of various ZENworks 
features such as Remote Management.

If you cannot use the internal ZENworks CA, you can use an external CA and provide external server 
certificates for each Primary Server you install. See the following sections for detailed instructions on 
using external certificates:

 Section 7.1, “Generating a Certificate Signing Request (CSR),” on page 29

 Section 7.2, “Generating a Certificate by Using NetIQ ConsoleOne,” on page 30

 Section 7.3, “Generating a Certificate by Using NetIQ iManager,” on page 30

7.1 Generating a Certificate Signing Request (CSR)
For each Windows server where you will install the ZENworks Primary Server software, you need to 
create an individual server certificate with the subject being the server’s Fully Qualified Domain Name 
(FQDN). 

1 Install OpenSSL.

2 To generate a private key that is needed to create a certificate signing request (CSR), enter the 
following command:

openssl genrsa -out zcm.pem 2048

3 To create a CSR that can be signed by a Certificate Authority, enter the following command:

openssl req -new -key zcm.pem -out zcm.csr

When you are asked for “YOUR name,” enter the full DNS name assigned to the server where 
you are installing the Primary Server software domain names include www.company.com, 
payment.company.com and contact.company.com.

4 To convert the private key from PEM format to the DER encoded format, enter the following 
command:

openssl pkcs8 -topk8 -nocrypt -in zcm.pem -inform PEM -out zcmkey.der -outform 
DER

The private key must be in the PKCS8 DER encoded format. You can use the OpenSSL 
command line tool to convert your keys to the proper format.

5 Use the CSR to generate a certificate by using ConsoleOne, iManager, or a true external CA 
such as Verisign.
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If you are using a true external CA such as Verisign, refer to Verisign for information about using 
the CSR to generate a certificate. If you are using ConsoleOne or iManager as your Certificate 
Authority, instructions are provided in the following sections: 

 Section 7.2, “Generating a Certificate by Using NetIQ ConsoleOne,” on page 30

 Section 7.3, “Generating a Certificate by Using NetIQ iManager,” on page 30

7.2 Generating a Certificate by Using NetIQ 
ConsoleOne

1 Ensure that eDirectory is configured as the CA.

2 Issue the certificate for the Primary Server:

2a Launch ConsoleOne.

2b Log in to the eDirectory tree as an administrator with the appropriate rights. 

For more information about the appropriate rights, see the Entry Rights Needed to Perform 
Tasks (https://www.netiq.com/documentation/crt33/crtadmin/data/a2zibyo.html) section in 
the NetIQ Certificate Server 3.3 documentation.

2c From the Tools menu, click Issue Certificate.

2d Browse for and select the zcm.csr file, then click Next. 

2e Complete the wizard by accepting the default values. 

2f Specify the certificate basic constraints, then click Next.

2g Specify the validity period and the effective and expiration dates, then click Next.

2h Click Finish.

2i Choose to save the certificate in the DER-format, then specify a name for the certificate.

3 Export the Organizational CA's self-signed certificate:

3a Log in to eDirectory from ConsoleOne.

3b In the Security container, right-click the CA, then click Properties.

3c In the Certificates tab, select the self-signed certificate.

3d Click Export.

3e When prompted to export the private key, click No.

3f Export the certificate in DER format and choose the location where you want to save the 
certificate.

3g Click Finish.

You should now have the three files that you need to install ZENworks using an external CA.

7.3 Generating a Certificate by Using NetIQ iManager
1 Ensure that eDirectory is configured as the CA.

2 Issue the certificate for the Primary Server:

2a Launch iManager.

2b Log in to the eDirectory tree as an administrator with the appropriate rights. 
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For more information about the appropriate rights, see the Entry Rights Needed to Perform 
Tasks (https://www.netiq.com/documentation/crt33/crtadmin/data/a2zibyo.html) section in 
the NetIQ Certificate Server 3.3 documentation.

2c From the Roles and Tasks menu, click Novell Certificate Server > Issue Certificate.

2d Click Browse to browse for and select the CSR file, zcm.csr, then click Next.

2e Accept the default values for the key type, the key usage, and the extended key usage, then 
click Next.

2f Accept the default certificate basic constraints, then click Next.

2g Specify the validity period and the effective and expiration dates, then click Next. Depending 
on your needs, change the default validity period (10 years). 

2h Review the parameters sheet. If it is correct, click Finish. If it is incorrect, click Back until you 
reach the point where you need to make changes.

When you click Finish, a dialog box is displayed and indicates that a certificate has been 
created. This exports the certificate into the binary DER-format.

2i Download and save the issued certificate

3 Export the Organizational CA's self-signed certificate:

3a Log in to eDirectory from iManager.

3b From the Roles and Tasks menu, click Novell Certificate Server > Configure Certificate 
Authority.

This displays the property pages for the Organizational CA, which include a General page, 
a CRL Configuration page, a Certificates page, and other eDirectory-related pages.

3c Click Certificates, then select Self Signed Certificate.

3d Click Export.

This starts the Certificate Export wizard.

3e Deselect the Export the Private Key option, and choose the export format as DER.

3f Click Next, then save the exported certificate.

3g Click Close.

You should now have the three files that you need to install ZENworks using an external CA.
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8 8Installing an External ZENworks 
Database

ZENworks requires two databases, one for general data and another for audit data. For these 
databases, you can use the embedded Sybase database software provided with ZENworks, or you 
can use a supported external database software (see Database Requirements). 

If you want to use the embedded database, skip the remainder of this section. You will install the 
embedded database during the installation of the ZENworks Primary Server software (see Installing 
the Primary Server Software).

 Section 8.1, “Prerequisites for External Databases,” on page 33

 Section 8.2, “Performing the External ZENworks Database Installation,” on page 36

8.1 Prerequisites for External Databases
Review the following sections to meet any prerequisites for the external database you plan to use:

 Section 8.1.1, “Prerequisites for Remote OEM Sybase,” on page 33

 Section 8.1.2, “Prerequisites for Remote Sybase SQL Anywhere,” on page 33

 Section 8.1.3, “Prerequisites for Microsoft SQL Server,” on page 34

 Section 8.1.4, “Prerequisites for Oracle,” on page 34

8.1.1 Prerequisites for Remote OEM Sybase

Before installing ZENworks 11 SP3 to create the Management Zone, you must install the remote 
OEM Sybase database on your remote database server so that it can be properly configured during 
installation of the Primary Server that hosts the database.

NOTE: For this database, Novell Support provides problem determination, provision of compatibility 
information, installation assistance, usage support, ongoing maintenance, and basic troubleshooting. 
For additional support, including extended troubleshooting and error resolution, see the Sybase 
Support web site (http://www.sybase.com/support).

8.1.2 Prerequisites for Remote Sybase SQL Anywhere

To use the Sybase SQL Anywhere database, ensure that the following prerequisites are met:

 Install and set up the Sybase SQL Anywhere database so that it can be updated during 
ZENworks installation.

 During ZENworks installation, you must specify a database user. Ensure that the database user 
has read/write permissions to create and modify the tables on the database server.
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NOTE: For this database, Novell Support provides problem determination, provision of compatibility 
information, installation assistance, usage support, ongoing maintenance, and basic troubleshooting. 
For additional support, including extended troubleshooting and error resolution, see the Sybase 
Support web site (http://www.sybase.com/support).

8.1.3 Prerequisites for Microsoft SQL Server

To use the Microsoft SQL Server database for ZENworks 11, ensure that the Microsoft SQL Server 
software is installed on the database server so that the ZENworks installation program can create the 
new Microsoft SQL database. For instructions on installing the Microsoft SQL Server software, refer 
to the Microsoft documentation.

For MS SQL, set the READ_COMMITTED_SNAPSHOT setting to ON so that it allows read access to 
information in the database while data is being written or modified.

To set the READ_COMMITTED_SNAPSHOT setting to ON, execute the following command at the 
database server prompt:

ALTER DATABASE database_name SET READ_COMMITTED_SNAPSHOT ON;

8.1.4 Prerequisites for Oracle

During the installation of the ZENworks database on Oracle, you can choose to create a new user 
schema or specify an existing one that resides on a server in your network.

 Create a new user schema: Ensure that the following requirements are met:

 You must have the database administrator credentials. Ensure that the administrator has 
Data Definition Language (DDL) and Redefinition rights with the Grant option enabled.

 A tablespace is needed for the Oracle access user. A tablespace is a storage location 
where the actual data underlying database objects can be kept. It provides a layer of 
abstraction between physical and logical data, and serves to allocate storage for all DBMS 
managed segments. (A database segment is a database object which occupies physical 
space such as table data and indexes.) Once created, a tablespace can be referred to by 
name when creating database segments.

 The tablespace can be created by ZENworks or can be created by the Database 
Administrator.

 The tablespace has sufficient space to create and store the ZENworks database schema. 
The tablespace requires a minimum of 10 GB to create ZENworks database schema.

 Use an existing user schema: You can install to an existing Oracle user schema in the 
following scenarios:

 The database administrator creates a user schema with the necessary rights, and you 
receive the credentials for that user schema from the database administrator. Database 
administrator credentials are not required to install to an existing Oracle user schema.

 You create a user in the Oracle database and choose to use it during ZENworks installation.

If you choose to use an existing user schema, ensure that the following requirements are met:

 The tablespace has sufficient space to create and store the ZENworks database schema. 
The tablespace requires a minimum of 10 GB to create the ZENworks database schema.

 The quota for the user schema is set to Unlimited on the tablespace that is required during 
installation.
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 Rights to create the database:  Ensure that the user schema has the following rights to create 
the database:

CREATE SESSION

CREATE_TABLE

CREATE_VIEW

CREATE_PROCEDURE

CREATE_SEQUENCE

CREATE_TRIGGER

ALTER ANY TABLE

DROP ANY TABLE

LOCK ANY TABLE

SELECT ANY TABLE

CREATE ANY TABLE

CREATE ANY TRIGGER

CREATE ANY INDEX

CREATE ANY DIMENSION

CREATE ANY EVALUATION CONTEXT

CREATE ANY INDEXTYPE

CREATE ANY LIBRARY

CREATE ANY MATERIALIZED VIEW

CREATE ANY OPERATOR

CREATE ANY PROCEDURE

CREATE ANY RULE

CREATE ANY RULE SET

CREATE ANY SYNONYM

CREATE ANY TYPE

CREATE ANY VIEW

DBMS_DDL

DBMS_REDEFINITION

DBMS_LOCK 

IMPORTANT: The above privileges are used to modify tables only in ZENworks schema and not 
in any other schema. The DBMS_DDL and DBMS_REDEFINITION packages are used to restructure 
some of the tables as partitioning tables during the upgrade or fresh installation of   ZENworks 
11.3.

You can give the DBMS_DDL and DBMS_REDEFINITION rights to the user at the time of installation 
or upgrade. After the installation or upgrade is successful, you can revoke the DBMS_DDL and 
DBMS_REDEFINITION rights and also those privileges with ANY option. 

For more details, see the Oracle database documentation (http://docs.oracle.com/cd/
B28359_01/server.111/b28310/tables007.htm#i1006801).

For Oracle databases, performance can be affected by whether you configure your database to 
use a shared server or dedicated server processes. Each ZENworks Primary Server is 
configured with a database connection pool whose size fluctuates with the ZENworks system 
load. This pool can grow at peak loads to a maximum of 300 concurrent database connections 
per Primary Server. If your Oracle database is configured to use dedicated server processes, it is 
possible that your database server resource usage can reach undesirable levels that affect 
performance when there are multiple Primary Servers in your zone. If you encounter this 
problem, consider changing your ZENworks database to use shared server processes.
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Prerequisites for Oracle RAC

 Oracle database and Real Application Clusters (RAC) version must be 11.2.0.4 or above.

 Tablespaces must be created by your database administrator manually (do not use ZENworks to 
create the tablespaces).

 Shut down ZENworks services on all Primary Servers and Reporting Server before upgrading  
ZENworks.

8.2 Performing the External ZENworks Database 
Installation
This section provides instructions for installing the ZENworks database by running the ZENworks 
installation program on the database server. This method is required if you are using a remote OEM 
Sybase database. For other databases, this method is useful if your ZENworks administrator and 
database administrator are not the same person.

You can also install your external ZENworks database when you install the ZENworks Primary Server 
software on the target Windows server. If you want to use this method, skip this section and go to 
Chapter 9, “Installing a ZENworks Primary Server on Windows,” on page 45.

Ensure that the server where you plan to install the external database fulfills the requirements in 
Chapter 2, “Database Requirements,” on page 15 and “Prerequisites for External Databases” on 
page 33.

1 On the server where you want to install the external database, insert the Novell ZENworks 11 
SP3 installation DVD.

IMPORTANT: If you have not already burned the ZENworks 11 SP3 ISO image to a DVD, you 
need to do so before beginning the installation. Do not extract the ISO image and use it to install.

If the DVD auto-runs the database installation program, exit the program.

Enter the following at the command prompt on the external database server:

DVD_drive:\setup.exe -c

or

If ZENworks 11 SP3 has already been installed on a device, and if you want to use the device to 
configure another instance of the ZENworks database (on the same device or on another 
device) by using the external database installation program, run the following command:

DVD_drive:\setup.exe -c --zcminstall

2 On the Select ZENworks Database page, select one of the following:

 Select ZENworks Database

 Select Audit Database 

 Select both ZENworks Database and Audit Database

NOTE: When the ZENworks Database and Audit Database option is selected, you need to 
create the ZENworks database first and then create the audit database.

The supported combinations of ZENworks and Audit database are shown below: 
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3 On the Select Database type page, select one of the following, then click Next:

 OEM Sybase SQL Anywhere: Installs the default Sybase database for ZENworks. It is 
configured as a service, the database user is created, and the required tables for the 
Primary Server are established.

You must also select the Remote Sybase SQL Anywhere option during installation of the 
Primary Server.

 External Sybase SQL Anywhere: Sets up an existing Sybase database for writing 
ZENworks information to it.

 Microsoft SQL Server: Creates a ZENworks database on a Microsoft SQL Server.

 Oracle: Specifies a user schema that you can use to set up an external Oracle database 
schema for use with ZENworks.

IMPORTANT: The server hosting the database must have time synchronization with all of the 
Primary Servers in the Management Zone.

4 Refer to the following information for details on the installation data that you need to know (you 
can also click the Help button for similar information):

 “OEM Sybase SQL Anywhere Database Installation Information” on page 37

 “External Sybase SQL Anywhere Database Installation Information” on page 39

 “MS SQL Database Installation Information” on page 41

 “Oracle Database Installation Information” on page 42

8.2.1 OEM Sybase SQL Anywhere Database Installation 
Information

ZENworks Database Audit Database

OEM Sybase SQL Anywhere  OEM Sybase SQL Anywhere (Default)

 External Sybase SQL Anywhere

External Sybase SQL Anywhere  External Sybase SQL Anywhere (Default)

 OEM Sybase SQL Anywhere 

Microsoft SQL Server Microsoft SQL Server

Oracle Oracle

Installation 
Information

Explanation

Sybase Database 
Installation

Specify the path where you want to install the OEM copy of the 
Sybase SQL Anywhere database software. On the target Windows 
server, only the drives that are currently mapped on the server are 
available.

The default path is drive:\novell\zenworks, which you can 
change. The installation program creates the \novell\zenworks 
directory for the installation of Sybase.
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Sybase Installation 
Path

Specify the path where you want to copy the Sybase installation 
file. The default path is: drive:\Program 
Files(x86)\Novell\ZENworks.

Sybase Server 
Configuration

Specify the port used by the Sybase SQL Anywhere database 
server. By default, port 2638 is used for the ZENworks database 
and port 2639 is used for the Audit database. Change the default 
port number if you have a conflict.

Sybase Access 
Configuration

Defaults are provided for some of the information, which you can 
change as necessary:

 Database Name: Specify a name for the database to be 
created.

 Username: Specify a name to create a new user who can 
access the database.

 Password: Specify the password to be used to access the 
database.

 Database Server Name: Specify a name for the Sybase SQL 
Anywhere database server.

Database File 
Location

Specify the path where you want to create the ZENworks Sybase 
database file. By default, the installation program creates the 
drive:\novell\zenworks  directory, which you can change. A 
\database directory is appended to the default directory. 

For example, the default path is 
drive:\novell\zenworks\database.

The default path for the Audit database is the same as for the 
ZENworks database.

Review Database 
Information

Review the database configuration information. 

The Server Address field displays the IP address configured in the 
hosts file. This does not impact the database installation. The 
hosts file is located in the 
c:\windows\system32\drivers\etc directory.

The database driver information is automatically detected by the 
ZENworks database installer. 

Review SQL 
Scripts

Review the SQL scripts to be executed during the database 
creation.

Installation 
Information

Explanation
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8.2.2 External Sybase SQL Anywhere Database Installation 
Information

Review Database 
Creation 
Command

Review the commands used to create the database.

NOTE: 

Ensure that the ports used for ZENworks database and Audit 
database are included in firewall exception list. Run the following 
command:

netsh firewall set prtopening protocol = All port 
= <port number> name = <port name> mode = enable

Where: 

 port number: By default it is 2638 for ZENworks and 2639 
for Audit or any alternate port number that is configured. This 
command has to be executed separately for ZENworks 
database port and Audit database port. 

 port name: Specify the name used for the port.For example, 
ZENworks database port.

net start mpsSvc

Installation 
Information

Explanation

Installation 
Information

Explanation

Sybase Server 
Configuration

 Server name: We recommend that you identify the server by 
its DNS name rather than its IP address, to be in sync with 
certificates that are signed with DNS names.

IMPORTANT: If you change your database server’s IP address 
or DNS name at a later time, ensure that your corporate DNS 
server is updated with this change to keep DNS for the 
database server in sync.

 Port: Specify the port used by the Sybase SQL Anywhere 
database server. The default is port 2638. For the Audit 
database, the default is port 2639. Change the default port 
number if you have a conflict.

Sybase Access 
Configuration

This server must have a Sybase SQL Anywhere database installed. 
Defaults are provided for some of this information, which can be 
changed as necessary:

 Database Name: Specify the name of the existing database

 Username: Specify the user who can modify the database. The 
user must have read/write permissions to modify the database.

 Password: Specify the password of an existing user with read/
write permissions to the database.

 Database Server Name: Specify the name of your Sybase 
SQL Anywhere database server.
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Review Database 
Information

Review the database configuration information.

The database driver information is automatically detected by the 
ZENworks Database installer.

Review SQL 
Scripts

Review the SQL scripts to be executed during the creation of the 
database.

Review Database 
Creation 
Commands

Review the database commands used to create the database.

Installation 
Information

Explanation
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8.2.3 MS SQL Database Installation Information

Installation 
Information

Explanation

External Database 
Server 
Configuration

The database server must have an MS SQL database installed. 
Defaults are provided for some of this information, which can be 
changed as necessary:

 Server Address: We recommend that you identify the server 
by its DNS name rather than its IP address, to be in sync with 
certificates that are signed with DNS names.

IMPORTANT: If you change your database server’s IP 
address or DNS name at a later time, ensure that your 
corporate DNS server is updated with this change to keep 
DNS for the database server in sync.

 Port: Specify the port used by the MS SQL database server. 
The default is port 1433. Change the default port number if 
you have a conflict.

 Named instance: This is the name of the SQL server 
instance that is hosting the existing ZENworks database. You 
must specify the named instance if you want it to be 
something other than the default of mssqlserver.

 Database Name: Specify the name of the existing MS SQL 
database on which you want to host the ZENworks database. 
This option is available only for an existing database.

 Username: Specify the user who can modify the database. 
The user must have read/write permissions to modify the 
database.

NOTE:  Ensure that the special character ' is not part of the 
database name.

For Windows authentication, provide a user name on the 
current device or in the domain. 

IMPORTANT: The installer wizard continues without validating 
the credentials; therefore, ensure that the correct credentials 
are provided. Else, the installation might fail towards the end 
of the installation process.

For SQL authentication, provide a user name that matches 
that of a valid SQL user.

 Password: Type the password of the user specified in the 
Username field.

 Domain: It is important to know whether you installed the SQL 
Server by using SQL authentication, Windows authentication, 
or mixed. Ensure that you select the option that coincides with 
your SQL Server options; otherwise, the authentication will 
fail. 

If you are using MS SQL with Windows Authentication, the 
host name (not FQDN) of Active Directory is used.

If you are using Windows authentication, specify the Windows 
domain where the user you specified in the Username field 
exists. If you are not using a Windows domain, specify the 
server’s short name.
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8.2.4 Oracle Database Installation Information

External Database 
Configuration > 
Database Location 
(applicable only for 
the new database)

Specify the path of the existing MS SQL database file on the SQL 
server. By default, it is c:\database. 

NOTE: Ensure that the specified path exists on the device hosting 
the database before the installation starts.

Review Database 
Information

Review the database configuration information.

Review SQL 
Scripts

Review the SQL scripts to be executed during the creation of the 
database. You can only view the scripts.

Installation 
Information

Explanation

Installation 
Information

Explanation

Oracle User 
Schema Options

You can either create a new user schema or specify an existing one 
that resides on a server in your network. You can use the user 
schema to set up an external Oracle database schema for use with 
ZENworks.

If you are creating a new user schema, a tablespace must already 
exist for associating to the Oracle access user. In an existing user 
schema, the rights and tablespace must already be set up.

Oracle Server 
information

The database server must have an Oracle database installed. 
Defaults are provided for some of this information, which can be 
changed as necessary:

 Server Address: We recommend that you identify the server 
by its DNS name rather than its IP address, to be in sync with 
certificates that are signed with DNS names.

IMPORTANT: If change your database server’s IP address or 
DNS name at a later time, ensure that your corporate DNS 
server is updated with this change to keep DNS for the 
database server in sync.

 Port: Specify the port used by the database server. The 
default is port 1521. Change the default port number if you 
have a conflict.

 Service Name: For a new user schema, specify the instance 
name (SID) on which the user schema is to be created. For an 
existing user schema, specify the instance name (SID) on 
which the user schema has been created.

Oracle 
Administrator 
(applicable only 
for the new user 
schema)

 Username:  Specify the user who can modify the database. 
The user must have read/write permissions to modify the 
database.

 Password: Specify the password to be used to the access the 
database.
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Oracle Access 
User

 Username: For a new user schema, specify a name. For an 
existing user schema, specify the name of the user schema 
that already exists in the Oracle database.

 Password: For a new user schema, specify a password to be 
used to access the database. For an existing user schema, 
specify the password used to access the user schema that 
already exists in the Oracle database. 

 Tablespace: For a new user schema, select one of the 
following tablespace options:

 Let ZENworks create the tablespace: Select this if you 
want ZENworks to create the tablespace.

 Let DBA create the tablespace: Select this if you want 
your database administrator to create the tablespace. 

The following details are required to create a new 
tablespace:

IMPORTANT: If you are using Automatic Storage 
Management

(ASM) or some other Disk storage, select Let DBA create 
the tablespace.

 Tablespace name for Tables (Ensure Tablespace 
name is unique and it should start with [a-z] | [A-
Z].Oracle tablespace naming convention has to be 
followed.)

 Tablespace name for Indexes (Ensure Tablespace 
name is unique and it should start with [a-z] | [A-
Z].Oracle tablespace naming convention has to be 
followed.)

 DBF File location for Tables

 DBF File location for Indexes (The specified 
physical path of the DBF file should be an existing 
path. The file name must have the .dbf extension.)

Review Database 
Information

Review the database configuration information.

Review SQL 
Scripts

Review the SQL scripts to be executed during the creation of the 
database.

Installation 
Information

Explanation
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9 9Installing a ZENworks Primary Server on 
Windows

Perform the tasks in the following sections to install the ZENworks Primary Server software on a 
Windows server:

 Section 9.1, “Installing the Primary Server Software,” on page 45

 Section 9.2, “Performing an Unattended Installation,” on page 46

 Section 9.3, “Verifying the Installation,” on page 48

 Section 9.4, “Installation Information,” on page 49

9.1 Installing the Primary Server Software
1 Log in to the installation server as a Windows administrator.

2  Insert the Novell ZENworks 11 SP3 installation DVD.

IMPORTANT: If you have not already burned the ZENworks 11 SP3 ISO image to a DVD, you 
need to do so before beginning the installation. Do not extract the ISO image and use it to install.

3 The installation page where you can select the language is displayed. If it is not automatically 
displayed after inserting the DVD, run setup.exe from the root of the DVD.

When installing ZENworks 11 SP3 on Windows, Strawberry Perl is installed in the root directory 
to meet the Perl runtime requirement for the ppkg_to_xml tool. 

4 During installation, refer to the information in Section 9.4, “Installation Information,” on page 49 
for details on the installation data that you need to know.

You can also click the Help button for information.

5 After installation is complete, do one of the following on the server:

 If you selected to reboot automatically (you selected the Yes, restart the system option 
during installation; see “Rebooting (or not)” on page 55), continue with Verifying the 
Installation after the booting process has completed and the services have started.

 If you selected to reboot manually (you selected the No, I will restart the system myself 
option during installation; see “Rebooting (or not)” on page 55), you must wait for the 
installation to complete and the services to start in order to verify it in Verifying the 
Installation.

NOTE: Part of completing the installation process is for the database to be updated and for the 
Product Recognition Update (PRU) to be downloaded and installed, both of which cause high 
CPU utilization during their processes. This can cause the services to start up slowly, which can 
also affect how long it takes for ZENworks Control Center to open.
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9.2 Performing an Unattended Installation
You can use a response file to perform an unattended installation of ZENworks 11 SP3. You can 
either edit the default response file (provided at 
DVD_drive:\Disk1\InstData\silentinstall.properties), or perform an installation to create 
your own version of the response file that contains the basic installation information and edit that copy 
as needed.

For an embedded Sybase database, you must create a response file to perform an unattended 
installation; you cannot reuse the response file generated for a server that uses an external database.

Do the following to create the response file, and then use it to perform an unattended installation:

 Section 9.2.1, “Creating Your Response File,” on page 46

 Section 9.2.2, “Performing the Installation,” on page 47

9.2.1 Creating Your Response File

1 Run the ZENworks 11 SP3 installation executable on a server by using the following command:

DVD_drive:\setup.exe -s

For more information, see Appendix A, “Installation Executable Arguments,” on page 107.

2 Ensure that during the installation you select the Yes, Generate the Response File with Restart 
Enabled option is selected so that server is automatically rebooted after the silent installation has 
completed.

A silent installation does not provide an installation progress bar.

3 When prompted, provide a path for your custom response file.

When you use the -s argument by itself, the installation program prompts you for a path for the 
response file. The default file name is silentinstall.properties, which you can rename later 
(see Step 4g).

4 Add the Management Zone and external database passwords to your custom response file.

Because the external database password that you enter during creation of the custom response 
file not saved in the response file, you must add the database and the Management Zone 
passwords in each copy of the response file in order for it to be correctly provided during an 
unattended installation. 

Optionally, you can create an environment variable to pass the password into the unattended 
installation. Instructions for this are contained in the response file where the password 
information is stored.

While you are editing the response file, you can make any other changes necessary to 
customize it for your unattended installation. The response file contains instructions for its 
various sections.

To add the external database and Management Zone passwords into the response file:

4a Open the response file in a text editor.

Your custom response file is in the location that you specified in Step 3.

If you are editing the default response file, it is located at 
DVD_drive:\Disk1\InstData\silentinstall.properties.

4b Search for ADMINISTRATOR_PASSWORD=.

4c Replace $lax.nl.env.ADMIN_PASSWORD$ with the actual password.

For example, if the password is novell, the entry will be:
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ADMINISTRATOR_PASSWORD=novell

4d (Conditional) If you are using an external database, search for the line, 
DATABASE_ADMIN_PASSWORD=, and replace $lax.nl.env.ADMIN_PASSWORD$ with the actual 
password.

4e (Conditional) If you are using an external database, search for the line, 
DATABASE_ACCESS_PASSWORD=, and replace $lax.nl.env.ADMIN_PASSWORD$ with the 
actual password.

4f Save the file and exit the editor.

4g Make as many uniquely named copies as you need for your various installation scenarios, 
modify each copy as necessary, then copy each one to the server where it will be used.

If you want to add another Primary Server to the existing Management Zone, you must 
provide the following information in the response file:

PRIMARY_SERVER_ADDRESS=$Primary_Server_IPaddress$

PRIMARY_SERVER_PORT=$Primary_Server_port$

PRIMARY_SERVER_CERT=-----BEGIN CERTIFICATE-----
MIID9DCCLotsOfEncryptedCharactersSja+bY05Y=-----END CERTIFICATE-----

where

PRIMARY_SERVER_ADDRESS is the IP address or DNS name of the parent Primary 
Server if the secondary server is being installed to an existing Management Zone.

PRIMARY_SERVER_PORT is the SSL port used by the parent Primary Server if the 
secondary server is being installed to an existing Management Zone. The default port is 
443.

PRIMARY_SERVER_CERT= is the certificate you specified on the parent Primary Server if 
the secondary server is being installed to an existing Management Zone. The certificate 
must be in the base64 encoded string format of an x509 certificate, and the certificate string 
must be specified in one line. The above is just an example of the certificate information. 

5 After you have completed modifications to your custom response file, copy it from the path that 
you specified in Step 3 to a location on each server where you will use it for the unattended 
installation.

6 To use the updated response file, continue with Section 9.2.2, “Performing the Installation,” on 
page 47.

NOTE: If you want to install Microsoft .NET when using a response file, you need to manually set 
the value in the file to INSTALL_DOT_NET=1.

9.2.2 Performing the Installation

1 On the Windows server where you want to perform the unattended installation, insert the Novell 
ZENworks 11 SP3 installation DVD.

If the installation page where you can select the language is displayed, click Cancel to exit the 
GUI installation.

2 To start the unattended installation, use the -f option in the command:

DVD_drive:\setup.exe -s -f path_to_file.

where path_to_file is either the full path to the response file that you created in Section 9.2.1, 
“Creating Your Response File,” on page 46, or a directory containing the 
silentinstall.properties file (it must use that file name).
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If you renamed the updated response file, include its new name with the path.

If a file name is not given, or if either the path or file does not exist, the -f parameter is ignored 
and the default installation is run instead of an unattended installation.

3 After the installation has completed, continue with Section 9.3, “Verifying the Installation,” on 
page 48.

9.3 Verifying the Installation
Perform the following steps to verify a successful installation.

1 After the server has rebooted, do any of the following to verify that the Primary Server is running:

 Run ZENworks Control Center 

If ZENworks Control Center does not automatically start, use the following URL to open it in 
a Web browser:

https://DNS_name_or_IP_address_of_Primary_Server/zenworks

If the Primary Server is not using the default HTTPS port, you must add the port to the URL: 
https://DNS_name_or_IP_address_of_Primary_Server:port_number/zenworks

This can be done either on the Primary Server or on a qualified workstation.

 Check the Windows services in the Windows Services list 

On the server, click Start, select Administrative Tools > Services, then review the status of 
the Novell ZENworks Loader and Novell ZENworks Server services.

If they are not running, start the ZENworks services. Right-click the Novell ZENworks 
Server service, then select Start. Right-click the Novell ZENworks Loader service, then 
select Start.

The Restart option stops all related services that are already running and starts each of 
them in their correct order, including Novell ZENworks Loader.

 Check the Windows services by using a command line 

Run the following command at the server command prompt:

ZENworks_installation_path\bin\novell-zenworks-configure -c SystemStatus

This lists all ZENworks services and their statuses.

To start the services, run the following command:

ZENworks_installation_path\bin\novell-zenworks-configure -c Start
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9.4 Installation Information

Installation 
Information

Explanation

Installation path The default is %ProgramFiles%. You can change it to any path currently available 
on the server, except to the %systemdrive%/Program Files directory if the 
server is a 64-bit Windows device. However, the installation path that you specify 
must contain English characters only.

NOTE: Installation from a mapped drive is not supported.

The installation program creates the Novell\ZENworks directory under this path for 
the installation of the ZENworks software files.

If you need more disk space for your content repository than what is available in the 
Windows path during installation, you can change the path to another location after 
completing the installation. For more information, see “Content Repository” in 
ZENworks 11 SP3 Primary Server and Satellite Reference.

Response file path 
(optional)

If you started the installation executable with the -s parameter in order to create a 
response file for unattended installations, you are required to provide a path for the 
file. The default path is C:\Documents and Settings\Administrator\. You 
can change this to any path available on the current server.

The Primary Server software is not installed when you run the program to create a 
response file. It only displays the installation pages necessary to identify and create 
the response file.

Prerequisites If the required prerequisites are not met, you are not allowed to continue with the 
installation. The requirements that are not fulfilled are displayed. For more 
information, see Chapter 1, “Primary Server Requirements,” on page 11.

If the .NET prerequisite is not fulfilled, you can click the ZENworks link in the 
description to install the runtime version that is bundled with ZENworks. After .NET is 
installed, the installation of ZENworks proceeds. This wizard might take a few 
seconds to launch.
Installing a ZENworks Primary Server on Windows 49

https://www.novell.com/documentation/zenworks113/pdfdoc/zen11_sys_servers/zen11_sys_servers.pdf#brwh44p
https://www.novell.com/documentation/zenworks113/pdfdoc/zen11_sys_servers/zen11_sys_servers.pdf#bookinfo


Management Zone New Zone:  If you are installing the first Primary Server, you need to know the name 
and password you want to use for the Management Zone. The password is used to 
log in to ZENworks Control Center.

Zone Name:  The zone name has a 20-character limit and should be a unique name. 
The zone name can contain only the following special characters: - (dash) _ 
(underscore) . (period). The zone name cannot contain special characters such as ~ .  
` ! @ # % ^ & * + = ( ) { } [ ] | \ : ; " ' < > , ? / $

For Embedded Sybase, ensure that the zone name is unique in your environment.

IMPORTANT: While installing ZENworks in a non-English language operating 
system, ensure that the Management Zone name does not use special characters 
from any other non-English language.For example, while installing ZENworks on a 
simplified Chinese operating system, ensure that the Zone name does not use "üöä" 
from the German Character Set.

Zone Password: By default, the installation creates a super administrator called 
Administrator. This super administrator has rights to perform all management tasks in 
your Management Zone and cannot be deleted. You must specify a password for 
Administrator. The password must contain a minimum of six characters and can 
included a maximum of 255 characters. The password can contain only one instance 
of the $ character.

After installation is complete, you can use ZENworks Control Center to create 
additional ZENworks administrator accounts for login to your Management Zone.

Port Number: During the installation of subsequent Primary Servers, the server by 
default uses the ports used by first Primary Server. If the ports are in use on the 
second Primary Server, you are asked to specify another port. Note which port you 
specify because you will need to use it in the URL for accessing ZENworks Control 
Center from that Primary Server.

Existing Zone: If you are installing to an existing Management Zone, you need to 
know the following information:

 The DNS name or IP address of an existing Primary Server in the zone. We 
recommend using the DNS name to provide ongoing synchronization with 
certificates that are signed with DNS names.

 The SSL port used by the existing Primary Server in the Management Zone. If 
the Primary Server uses a different port than the default (443), specify that port.

 A ZENworks administrator user name to log in to the zone. The default is 
Administrator. After completing the installation, you can use ZENworks 
Control Center to add other administrator names that can be used to log in to the 
Management Zone.

 The password for the administrator you specified in the Username field.

Database 
Configuration 
Recommendation

You can enter the number of devices used in thousands. For example enter 1 for 
1000 devices, 2 for 2000, and so on.The range of devices is between 1 to 100. Based 
on the number of devices, the database recommendation is displayed.

Installation 
Information

Explanation
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Database options ZENworks requires a database. The database options are displayed only when 
installing the first Primary Server to the zone. 

You have the following database options:

 Embedded Sybase SQL Anywhere: Automatically installs the embedded 
database on the local server.

If you select the embedded database option, no further database installation 
pages are shown.

 Remote Sybase SQL Anywhere: This database must already exist on a server 
in your network. It can be on the current server.

To select this option, you should already have followed the steps in 
“Prerequisites for Remote Sybase SQL Anywhere” on page 33.

You also use this option for installing to an existing remote OEM Sybase 
database.

 Microsoft SQL Server: You can create a new SQL database or specify an 
existing database that resides on a server in your network. It can be on the 
current server.

Creating a new SQL database at this time provides the same results as the 
steps in “Prerequisites for Microsoft SQL Server” on page 34.

 Oracle: Specifies a user schema that you can use to set up an external Oracle 
database schema for use with ZENworks.

You can either create a new user schema or specify an existing one that resides 
on a server in your network.

To select this option, you should already have followed the steps in 
“Prerequisites for Oracle” on page 34.

IMPORTANT: The following points must be considered for external databases:

 The time on the server hosting the database must be synchronized with each of 
the Primary Servers in the Management Zone. The external database can also 
reside on the Primary Server machine.

 If you have specified the database hostname, it must be DNS resolvable.

Installation 
Information

Explanation
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Database 
information

For the external database options (Remote Sybase SQL Anywhere, Microsoft SQL 
Server, and Oracle), you need to know the information listed below. Defaults are 
provided for some of this information, which can be changed as necessary.

 All Databases: The database server must have a Sybase SQL Anywhere, 
Microsoft SQL, or Oracle database installed.

 Server’s name. We recommend that you identify the server by its DNS 
name rather than its IP address, to be in sync with certificates that are 
signed with DNS names.

IMPORTANT: If you later change your database server’s IP address or 
DNS name, ensure that your corporate DNS server is updated with this 
change to keep DNS for the database server in sync.

 Port used by the database server.

Port 2638 is the default for Sybase SQL Anywhere and port 1433 is the 
default for Microsoft SQL Server.

Change the default port number if you have a conflict.

 (Optional) SQL Server Only: Named instance that is the name of the SQL 
server instance that is hosting the existing ZENworks database. You must 
specify the named instance if you want it to be something other than the default 
of mssqlserver.

 Oracle Only: The name of the tablespace where you want the database to be 
created. The default is USERS.

 New Database: 

 The database administrator (Username field) must have read/write 
permissions in order to successfully perform the required operations on the 
database.

 The administrator’s database password.

 SQL Server or New Database: 

 If you are using Windows authentication, specify the Windows domain 
where the user you specified in the Username field exists. If you are not 
using a Windows domain, specify the server’s short name.

 Whether to use Windows or SQL Server authentication. For Windows 
authentication, provide the credentials for a user on the current device or in 
the domain. For SQL authentication, provide credentials that match those 
of a valid SQL user.

It is important to know whether you installed the SQL Server by using SQL 
authentication, Windows authentication, or mixed. Be sure to select the option 
that coincides with your SQL Server options; otherwise, the authentication will 
fail.

Installation 
Information

Explanation
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Database access For the external database options (Remote Sybase SQL Anywhere, Microsoft SQL 
Server, and Oracle), you need to know the information listed below. Defaults are 
provided for some of this information, which can be changed as necessary.

 All Databases: This server must have a Sybase SQL Anywhere, Microsoft 
SQL, or Oracle database installed.

 Database name. Replace zenworks_MY_ZONE with either the desired 
database name or an existing database name.

 Database user name. This user must have read/write permissions to 
modify the database.

If Windows authentication is also selected, the specified user must already 
exist when you create a new SQL database. The user is granted login 
access to SQL Server and read/write access to the ZENworks database 
that is created.

For an existing database, specify a user with sufficient permissions to the 
database.

 Database password. For a new database, this password is automatically 
generated if SQL authentication is selected. For an existing database, 
specify the password of an existing user with read/write permissions to the 
database.

 Sybase Databases Only: The name of your Sybase SQL Anywhere database 
server.

 Oracle Databases Only: The name of the tablespace where you want the 
database to be created. By default, it is USERS.

 Microsoft SQL Databases Only: 

 If you are using Windows authentication, specify the Windows domain 
where the user you specified in the Username field exists. If you are not 
using a Windows domain, specify the server’s short name.

 Whether to use Windows or SQL Server authentication. For Windows 
authentication, provide the credentials for a user on the current device or in 
the domain. For SQL authentication, provide credentials that match those 
of a valid SQL user.

It is important to know whether you installed the SQL Server by using SQL 
authentication, Windows authentication, or mixed. Be sure to select the option 
that coincides with your SQL Server options; otherwise, the authentication will 
fail.

SSL configuration 
(shown only for the 
first server installed 
in the Management 
Zone)

In order to enable SSL communications, an SSL certificate must be added to the 
ZENworks server. Select whether to use an internal or external certificate authority 
(CA).

For subsequent installations of Primary Servers to the Management Zone, the CA 
established by the first server’s installation is used for the zone.

IMPORTANT: After you install ZENworks 11 SP3, you can only change the internal 
certificate to an external certificate on Primary Servers. For more information, see 
“Reconfiguring a Zone Certificate Before It Expires”in the ZENworks 11 SP3 Disaster 
Recovery Reference.

The Restore Default buttons restore the paths to those that were displayed when you 
first accessed this page.

Installation 
Information

Explanation
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Signed SSL 
certificate and 
private key

To enter a trusted CA-signed certificate and private key, click Choose to browse for 
and select the certificate and key files, or specify paths to the signed certificate to be 
used for this server (Signed SSL Certificate) and the private key associated with the 
signed certificate (Private Key). 

For subsequent installations of Primary Servers to the zone, the CA established for 
the zone by the first server’s installation is used. If the zone is using an internal CA, 
you must provide the IP address or DNS name of the Primary Server with CA role. 
Otherwise, the wizard will not proceed further.

For information on creating external certificates to select when installing to a Windows 
server, see Chapter 7, “Creating an External Certificate,” on page 29.

For information on creating external certificates for installing to a server using a silent 
installation, see Section 9.2.1, “Creating Your Response File,” on page 46.

Root certificate 
(optional)

To enter a trusted CA root certificate, click Choose to browse for and select it, or 
specify the path to the CA’s public X.509 certificate (CA Root Certificate).

Pre-installation 
summary

GUI Installation: To make changes to any information entered up to this point, click 
Previous. After you click Install, the installation of the files begins. During installation, 
you can click Cancel to stop, which leaves the files on your server that were installed 
up to that point.

Installation 
complete (roll back 
option)

If installation errors occurred, this page is displayed at this time; otherwise, it is 
displayed after the Post-Installation Actions page.

Installation Recovery: If there are serious installation errors, you can roll back the 
installation to return your server to its previous state. This option is provided on a 
different installation page. Otherwise, you have two options:

 If a previous installation was cut short and you install again, you might be given 
the option to reset the installation, depending on how far you got in the canceled 
installation. If you select to reset, this overwrites any configuration that might 
have occurred during the canceled installation.

 To undo a successfully completed installation, follow the instructions in the 
ZENworks 11 SP3 Uninstall Guide.

If there were serious installation errors, select Roll Back, which returns your server to 
its previous state. Upon exiting the installation program, the server is not rebooted. 
However, to complete the installation, you must reboot the server.

To determine whether to continue the installation or roll it back, review the log file that 
lists errors. This will help you determine whether any installation failures were 
significant enough for your action. If you select to continue, resolve the issues that are 
noted in the log after you have rebooted the server and completed the installation 
process.

To access the log file in the GUI installation, click View Log. 

Installation 
Information

Explanation
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Post installation 
actions

Options are presented for selecting actions to perform after the installation has 
successfully completed:

For the GUI installation, a page displays the options listed below. Some items are 
selected by default. Click any check box to select or deselect the option, then click 
Next to continue.

 Run ZENworks Control Center: (GUI installation only) Automatically opens 
ZENworks Control Center in your default web browser after rebooting (Windows 
only), or immediately if you select to reboot manually.

For the Oracle database, the administrator names are case sensitive. The 
default ZENworks administrator account that was automatically created during 
installation uses an initial capital letter. In order to log in to ZENworks Control 
Center, you must enter Administrator.

 Place a shortcut to ZENworks Control Center on the Desktop: Places the 
shortcut on your desktop.

 Place a shortcut to ZENworks Control Center in the Start Menu: Places the 
shortcut in your Start menu.

 View Readme file: For GUI installations, opens the ZENworks 11 SP3 Readme 
in your default browser after rebooting, or immediately if you select to reboot 
manually.

 View Installation log: Displays the installation log in your default XML viewer 
(GUI installation) after rebooting, or immediately if you select to reboot manually. 

ZENworks System 
Status Utility

Allows you to launch a ZENworks services heartbeat check prior to closing the 
installation program. Results are posted in the installation log.

Rebooting (or not) Upon a successful installation, you can select between rebooting immediately or later:

 Yes, Restart the System: If you select this option, log in to the server when 
prompted. The first time you log in to the server, it takes a few minutes because 
the database is being populated with inventory data.

 No, I Will Restart the System Myself: If you select this option, the database is 
immediately populated with inventory data.

The process of populating the database can cause high CPU utilization during a 
reboot or immediately after the installation program closes if you select not to reboot. 
This database updating process can slow down the starting of the services and 
access to ZENworks Control Center.

The Patch Management downloads might also cause high CPU utilization, usually 
shortly after rebooting.

Installation 
completion

The actions you selected previously are performed after all of the files have been 
installed for ZENworks 11 SP3 (if selected).

Installation 
Information

Explanation
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10 10Completing Post-Installation Tasks

After successfully installing the ZENworks Primary Server software, you might need to perform some 
of the following post-installation tasks. Not all tasks are required for all installations. However, we 
recommend that you review each section to ensure that you complete any tasks required for your 
installation.

 Section 10.1, “Licensing Products,” on page 57

 Section 10.2, “Enabling Access to a Primary Server Behind a NAT Firewall,” on page 58

 Section 10.3, “Adding Imaging Applications as Firewall Exceptions,” on page 58

 Section 10.4, “Supporting ZENworks 10.3.4 Device Upgrades,” on page 59

 Section 10.5, “Backing Up ZENworks Components,” on page 59

 Section 10.6, “Customizing ZENworks Control Center,” on page 60

 Section 10.7, “Supporting a Primary Server on VMware ESX,” on page 60

10.1 Licensing Products 
During the installation of your first ZENworks Primary Server and the creation of your Management 
Zone, the ZENworks installation program installs the following products and sets their license state as 
listed in the table.

You activate a product by supplying a valid product license. If you do not have a valid license, you can 
evaluate the product for 60 days. 

To change the license state of a product:

1 Log in to ZENworks Control Center.

2 Click Configuration.

3 In the Licenses panel, click a suite if you have a suite license key.

or

Click a product to provide a product license key or to turn on the product evaluation.

Product License State

Asset Inventory for UNIX/Linux Evaluation

Asset Inventory for Windows/Mac Deactivated

Asset Management Evaluation

Configuration Management Evaluation

Endpoint Security Management Deactivated

Full Disk Encryption Deactivated

Patch Management Activated
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For more information about activating and deactivating products, see the ZENworks 11 SP3 Product 
Licensing Reference.

10.2 Enabling Access to a Primary Server Behind a 
NAT Firewall
If the Primary Server is behind a NAT firewall, the devices on the Internet or public network cannot 
communicate with it. To resolve the issue, you must configure additional IP addresses or DNS names 
for the Primary Server through ZENworks Control Center.

For more information, see “Configuring Additional Access to a ZENworks Server” in the ZENworks 11 
SP3 Primary Server and Satellite Reference.

10.3 Adding Imaging Applications as Firewall 
Exceptions
The ZENworks installation program cannot add exceptions to a Windows server firewall. Therefore, 
you must manually complete this task under the following conditions:

 The Primary Server will be an Imaging Server.

 The Primary Server will be the parent Primary Server of an Imaging Satellite Server. 

Refer to the appropriate section for the Primary Server’s operating system:

 Section 10.3.1, “Adding Imaging Applications as Firewall Exceptions on Windows Server 2003,” 
on page 58

 Section 10.3.2, “Adding Imaging Applications as Firewall Exceptions on Windows Server 2008,” 
on page 59

10.3.1 Adding Imaging Applications as Firewall Exceptions on 
Windows Server 2003

1 From the desktop Start menu, click Settings > Control Panel.

2 Double-click Windows Firewall.

The Windows Firewall window is displayed.

3 Click the Exceptions tab.

4 Click Add Program.

The Add a Program window is displayed.

5 Click Browse to browse for and select novell-pbserv.exe. 

All of the Imaging applications, including novell-pbserv.exe, are located in the 
zenworks_installation_directory\novell\zenworks\bin\preboot directory.

6 Click OK.

novell-pbserv.exe is added to the Programs and Services list and is automatically enabled.

7 Repeat Step 4 through Step 6 to add the following Imaging applications to the Exceptions list:

 novell-proxydhcp.exe
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 novell-tftp.exe

 novell-zmgprebootpolicy.exe

8 Click OK.

10.3.2 Adding Imaging Applications as Firewall Exceptions on 
Windows Server 2008

1 From the desktop Start menu, click Settings > Control Panel.

2 Double-click Windows Firewall.

The Windows Firewall window is displayed.

3 In the left pane, click Allow a program or feature through Windows Firewall.

4 Click the Exceptions tab.

5 Click Add Program.

The Add a Program window is displayed.

6 Click Browse to browse for and select novell-pbserv.exe. 

All of the Imaging applications, including novell-pbserv.exe, are located in the 
zenworks_installation_directory\novell\zenworks\bin\preboot directory.

7 Click OK.

novell-pbserv.exe is added to the Programs and Services list and is automatically enabled.

8 Repeat Step 5 through Step 7 to add the following Imaging applications to the Exceptions list:

 novell-proxydhcp.exe

 novell-tftp.exe

 novell-zmgprebootpolicy.exe

9 Click OK.

10.4 Supporting ZENworks 10.3.4 Device Upgrades
If you have ZENworks 10.3. 4 managed devices or Satellite Servers in your network and want to 
register the devices to a new ZENworks 11 SP3 Management Zone so that they can be automatically 
upgraded to ZENworks 11 SP 3, you must import the ZENworks 11 SP3 System Update into the zone 
from the ZENworks 11 SP3 installation media. For detailed information, see TID 7007958 in the 
Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).

10.5 Backing Up ZENworks Components 
We recommend that you implement the following backup best practices:

 Take reliable backups of the ZENworks database and Audit database on a regular basis. For 
instructions, see the ZENworks 11 SP3 Database Management Reference.

 Procure and note the credentials of the databases:

 For the embedded Sybase ZENworks database, use the following command: 

zman dgc -U administrator_name -P administrator_password

 For the embedded Sybase Audit database, use the following command: 
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zman dgca -U admimistrator_name -P administrator_password

 For an external database, contact the database administrator.

 Take a reliable backup of the Primary Server (this only needs to be done one time). For 
instructions, see “Backing Up a ZENworks Server”in the ZENworks 11 SP3 Disaster Recovery 
Reference.

 Take a reliable backup of the Certificate Authority. For instructions, see “Backing Up the 
Certificate Authority”in the ZENworks 11 SP3 Disaster Recovery Reference.

10.6 Customizing ZENworks Control Center
ZENworks Control Center provides a configuration file that you can use to customize how it functions. 
For example, you can change the default timeout from 30 minutes to another value.

For instructions, see “Customizing ZENworks Control Center” in the ZENworks 11 SP3 ZENworks 
Control Center Reference.

10.7 Supporting a Primary Server on VMware ESX 
If you installed the Primary Server software on a virtual machine running on VMware ESX, complete 
the following tasks:

 Section 10.7.1, “Adjusting the Reserved Memory Size,” on page 60

 Section 10.7.2, “Enabling Large Page Support,” on page 60

10.7.1 Adjusting the Reserved Memory Size

For optimal performance, set the reserved memory size to the size of the guest operating system 
memory. For more information, see TID 7005382 in Novell Support Knowledgebase (http://
support.novell.com/search/kb_index.jsp).

10.7.2 Enabling Large Page Support

For optimal performance of large dataset handling, you should enable Java large page support:

1 At the server’s command prompt, run the following command to launch the Novell ZENworks 
Server Properties dialog box:

zenserverw

2 In the Java tab, add the following option to the Java Options box:

-XX:+UseLargePages

Ensure that you add the option on its own line.

3 Restart the Primary Server:

3a Click Start > Settings > Control Panel > Administrative Tools > Services.

3b Select Novell ZENworks Server, then click Restart in the left pane.

If the Primary Server fails to start, there is either a compatibility problem with the newly added option 
or the syntax is incorrect. To troubleshoot the service startup, run zenserverw and enable the logging 
options on the Logging tab:

 Set the log path. For example, C:\
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 Set the Redirect Stdout.log. For example, c:\stdout.log

 Set the Redirect Stderr.log. For example, c:\stderr.log
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III IIILinux Installation

The following section provides information and instructions to help you install the ZENworks Primary 
Server software on a Linux server:

 Chapter 11, “Linux Installation Workflow,” on page 65

 Chapter 12, “Understanding What the ZENworks Installation Does,” on page 69

 Chapter 13, “Updating Linux Server Software,” on page 71

 Chapter 14, “Creating an External Certificate,” on page 73

 Chapter 15, “Installing an External ZENworks Database,” on page 77

 Chapter 16, “Installing a ZENworks Primary Server on Linux,” on page 89

 Chapter 17, “Completing Post-Installation Tasks,” on page 101
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11 11Linux Installation Workflow

The tasks you must complete to install your first ZENworks Primary Server are different from the 
tasks required for additional Primary Servers. The following sections provide the workflows for both 
processes: 

 Section 11.1, “Installation Workflow for Your First Primary Server,” on page 65

 Section 11.2, “Installation Workflow for Additional Primary Servers,” on page 67

11.1 Installation Workflow for Your First Primary Server
To install the first ZENworks Primary Server and create your ZENworks Management Zone, complete 
the tasks in the order listed below.

To add a Primary Server to an existing ZENworks Management Zone, see Section 11.2, “Installation 
Workflow for Additional Primary Servers,” on page 67.

Task Details

 Review what the ZENworks installation program 
does when installing the first Primary Server and 
Management Zone. 

When installing the first Primary Server, the 
installation program performs operations to install 
the Primary Server software, set up the ZENworks 
databases, and establish the Management Zone.

For more information, see Chapter 12, 
“Understanding What the ZENworks Installation 
Does,” on page 69.

 Burn the ZENworks ISO image to a DVD to create 
an installation DVD.

You cannot extract the ISO image and use it to 
install. The installation must be run from an 
installation DVD.

 Update the software on the Linux server where you 
will install the ZENworks Primary Server.

Ensure that the Linux server software is up to date 
and that any software, such as anti-virus software, 
that might interfere with the Primary Server 
installation is updated and configured correctly.

For more information, see Chapter 13, “Updating 
Linux Server Software,” on page 71.
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 Create an external certificate for your Primary 
Server.

ZENworks Primary Servers communicate with 
ZENworks managed devices using the HTTPS 
protocol. This secure communication requires that 
the ZENworks Management Zone have a defined 
Certificate Authority (CA) and that each Primary 
Server have its own server certificate issued by the 
zone's CA.

ZENworks includes an internal ZENworks CA. If 
you use the internal ZENworks CA, it is created 
during installation of the first Primary Server, and 
each subsequent Primary Server you install is 
issued a certificate signed by the ZENworks CA.

We recommend that you use the internal ZENworks 
CA unless your corporate security policies do not 
allow you to do so. The internal ZENworks CA lasts 
10 years and simplifies use of various ZENworks 
features such as Remote Management.

If you cannot use the internal ZENworks CA, you 
can use an external CA and provide external server 
certificates for each Primary Server you install.

If you want to use external certificates, see 
Chapter 14, “Creating an External Certificate,” on 
page 73.

 Install external database software to use for the 
ZENworks databases.

ZENworks requires two databases, one for general 
data and another for audit data. For these 
databases, you can use the embedded Sybase 
database software provided with ZENworks, or you 
can use supported external database software (see 
Chapter 2, “Database Requirements,” on page 15).

If you want to use an external database, see 
Chapter 15, “Installing an External ZENworks 
Database,” on page 77.

 Install the ZENworks Primary Server software on a 
supported Linux server.

For instructions, see Section 16.1, “Installing the 
Primary Server Software,” on page 89.

 Verify that the Primary Server is running. There are specific checks you can perform to 
ensure that installation of the software was 
successful and that the Primary Server is running.

For instructions, see Section 16.3, “Verifying the 
Installation,” on page 92.

 Activate the ZENworks products for which you are 
licensed or that you want to evaluate.

All ZENworks products are installed. However, you 
need to provide the license keys the products that 
you have licensed. If desired, you can also activate 
unlicensed products for a 60-day evaluation period.

For instructions, see Section 17.1, “Licensing 
Products,” on page 101.

Task Details
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11.2 Installation Workflow for Additional Primary 
Servers
To install a ZENworks Primary Server and add it to your existing ZENworks Management Zone, 
complete the tasks in the order listed below.

 Back up the ZENworks Primary Server and other 
ZENworks components.

You should back up the Primary Server at least one 
time and schedule regular back ups of the 
ZENworks databases.

For instructions, see Section 17.4, “Backing Up 
ZENworks Components,” on page 102.

 Review the post-installation tasks and complete any 
that apply to your Primary Server installation.

There are several post-installation tasks that you 
might need to perform for your Primary Server. 
Review the list of tasks and complete any that 
apply.

For instructions, see Chapter 17, “Completing Post-
Installation Tasks,” on page 101.

Task Details

Task Details

 Review what the ZENworks installation program 
does when adding a Primary Server to an existing 
Management Zone. 

When installing an additional Primary Server in a 
Management Zone, the installation program 
performs operations to install the Primary Server 
software, add the Primary Server to the existing 
Management Zone, install ZENworks Control 
Center, start the ZENworks services.

For more information, see Chapter 12, 
“Understanding What the ZENworks Installation 
Does,” on page 69.

 Burn the ZENworks ISO image to a DVD to create 
an installation DVD.

You cannot extract the ISO image and use it to 
install. The installation must be run from an 
installation DVD.

 Update the software on the Linux server where you 
will install the ZENworks Primary Server.

Ensure that the Linux server software is up to date 
and that any software, such as anti-virus software, 
that might interfere with the Primary Server 
installation is updated and configured correctly.

For more information, see Chapter 13, “Updating 
Linux Server Software,” on page 71.
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 Create an external certificate for your Primary 
Server.

If your ZENworks Management Zone is using the 
internal ZENworks Certificate Authority (CA), the 
new Primary Server is automatically issued a server 
certificate during installation. 

If your zone is using an external CA, you must 
provide the new Primary Server with a valid 
certificate issued from the external CA. 

For instructions about creating a certificate from an 
external CA, see Chapter 14, “Creating an External 
Certificate,” on page 73.

 Install the ZENworks Primary Server software on a 
supported Linux server.

Installation of an additional Primary Server is less 
complex than installation of the first Primary Server. 
The installation program only requires you to 
provide a target location for the software files, 
authentication information for the Management 
Zone (Primary Server address and Administrator 
login credentials), and files for the external 
certificate (if the zone is using an external CA).

For instructions about running the installation 
program, see Section 16.1, “Installing the Primary 
Server Software,” on page 89.

 Verify that the Primary Server is running. There are specific checks you can perform to 
ensure that installation of the software was 
successful and that the Primary Server is running.

For instructions, see Section 16.3, “Verifying the 
Installation,” on page 92.

 Back up the ZENworks Primary Server. You should back up the Primary Server at least one 
time.

For instructions, see Section 17.4, “Backing Up 
ZENworks Components,” on page 102.

 Review the post-installation tasks and complete any 
that apply to your Primary Server installation.

There are several post-installation tasks that you 
might need to perform for your Primary Server. 
Review the list of tasks and complete any that 
apply.

For instructions, see Chapter 17, “Completing Post-
Installation Tasks,” on page 101.

Task Details
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12 12Understanding What the ZENworks 
Installation Does

The ZENworks installation program does the following during installation of your first Primary Server:

 Creates the Management Zone

 Creates a password that you supply for the default ZENworks Administrator account

 Establishes and populates the ZENworks database and Audit database

The ZENworks installation program does the following during installation of any Primary Server:

 Installs the ZENworks Adaptive Agent so that the server can be managed

 Installs ZENworks Control Center, the web console used to manage your ZENworks System 

 Installs the zman command line utility

 Installs and starts the ZENworks services
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13 13Updating Linux Server Software

Before installing ZENworks Primary Server software to a Linux server, ensure that you update the 
software on the server:

 Section 13.1, “All Linux Platforms,” on page 71

 Section 13.2, “SLES 11 x86_64,” on page 71

13.1 All Linux Platforms
 ZENworks installation on a Linux server requires that certain RPM packages are already 

installed on the server. For more information on the RPM packages required on the Linux 
devices, see Dependent Linux RPM Packages.

 Run Linux Update on the server to ensure that all available updates are installed. When finished, 
disable Linux Update to prevent failure of the Primary Server software installation due to parallel 
installation of updates.

 Update other software (for example, anti-virus) to prevent failure of the Primary Server software 
installation due to parallel installation of updates.

 If you are testing or reviewing ZENworks 11 SP3, we recommend that you deploy the product in 
a non-production environment.

13.2 SLES 11 x86_64
Before you install a Primary Server on a SLES 11 x86_64 device, ensure that pam-32bit libraries are 
installed on the device, because the CASA rpms are dependent on these libraries.

1 Log in to the Linux device as the root user.

2 Insert the Linux installation media.

3 Run Yast to open the YaST Control Center.

4 Click Software > Software Management.

5 In the Search option, specify CASA, then click OK to list all the CASA packages.

6 Select the pam-32 package, then click Install > Apply.
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14 14Creating an External Certificate

ZENworks Primary Servers communicate with ZENworks managed devices using the HTTPS 
protocol. This secure communication requires that the ZENworks Management Zone have a defined 
Certificate Authority (CA) and that each Primary Server have its own server certificate issued by the 
zone's CA.

ZENworks includes an internal ZENworks CA. If you use the internal ZENworks CA, it is created 
during installation of the first Primary Server. Each subsequent Primary Server you install is issued a 
certificate signed by the ZENworks CA.

We recommend that you use the internal ZENworks CA unless your corporate security policies do not 
allow you to do so. The internal ZENworks CA lasts 10 years and simplifies use of various ZENworks 
features such as Remote Management.

If you cannot use the internal ZENworks CA, you can use an external CA and provide external server 
certificates for each Primary Server you install. See the following sections for detailed instructions on 
using external certificates:

 Section 14.1, “Generating a Certificate Signing Request (CSR),” on page 73

 Section 14.2, “Generating a Certificate by Using NetIQ ConsoleOne,” on page 74

 Section 14.3, “Generating a Certificate by Using NetIQ iManager,” on page 74

14.1 Generating a Certificate Signing Request (CSR)
For each Linux server where you will install the ZENworks Primary Server software, you need to 
create an individual server certificate with the subject being the server’s Fully Qualified Domain Name 
(FQDN). 

1 Install OpenSSL.

2 To generate a private key that is needed to create a certificate signing request (CSR), enter the 
following command:

openssl genrsa -out zcm.pem 2048

3 To create a CSR that can be signed by the external Certificate Authority, enter the following 
command:

openssl req -new -key zcm.pem -out zcm.csr

When you are asked for “YOUR name,” enter the full DNS name assigned to the server where 
you are installing the Primary Server software domain names include www.company.com, 
payment.company.com and contact.company.com.

4 To convert the private key from PEM format to DER format, enter the following command:

openssl pkcs8 -topk8 -nocrypt -in zcm.pem -inform PEM -out zcmkey.der -outform 
DER

The private key must be in the PKCS8 DER format. You can use the OpenSSL command line 
tool to convert your keys to the proper format. This tool can be obtained as part of the Cygwin 
toolkit, or as part of your Linux distribution.
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5 Use the CSR and generate a certificate by using Novell ConsoleOne, Novell iManager or a true 
external CA such as Verisign.

 Section 14.2, “Generating a Certificate by Using NetIQ ConsoleOne,” on page 74

 Section 14.3, “Generating a Certificate by Using NetIQ iManager,” on page 74

14.2 Generating a Certificate by Using NetIQ 
ConsoleOne

1 Ensure that eDirectory is configured as the CA.

2 Issue the certificate for the Primary Server.

2a Launch ConsoleOne.

2b Log in to the eDirectory tree as an administrator with the appropriate rights. 

For more information about the appropriate rights, see the Entry Rights Needed to Perform 
Tasks (https://www.netiq.com/documentation/crt33/crtadmin/data/a2zibyo.html) section in 
the NetIQ Certificate Server 3.3 documentation.

2c From the Tools menu, click Issue Certificate.

2d Browse for and select the zcm.csr file, then click Next.

2e Complete the wizard by accepting the default values. 

2f Specify the certificate basic constraints, then click Next.

2g Specify the validity period and the effective and expiration dates, then click Next.

2h Click Finish.

2i Choose to save the certificate in the DER-format, then specify a name for the certificate.

3 Export the Organizational CA's self-signed certificate.

3a Log in to eDirectory from ConsoleOne.

3b In the Security container, right-click the CA, then click Properties.

3c In the Certificates tab, select the self-signed certificate.

3d Click Export.

3e When prompted to export the private key, click No.

3f Export the certificate in DER format and choose the location where you want to save the 
certificate.

3g Click Finish.

You should now have the three files that you need to install ZENworks using an external CA.

14.3 Generating a Certificate by Using NetIQ iManager
1 Ensure that eDirectory is configured as the CA.

2 Issue the certificate for the Primary Server.

2a Launch iManager.

2b Log in to the eDirectory tree as an administrator with the appropriate rights. 

For more information about the appropriate rights, see the Entry Rights Needed to Perform 
Tasks (https://www.netiq.com/documentation/crt33/crtadmin/data/a2zibyo.html) section in 
the NetIQ Certificate Server 3.3 documentation.
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2c From the Roles and Tasks menu, click Novell Certificate Server > Issue Certificate.

2d Click Browse to browse for and select the CSR file, zcm.csr.

2e Click Next.

2f Accept the default values for the key type, the key usage, and the extended key usage, then 
click Next.

2g Accept the default certificate basic constraints, then click Next.

2h Specify the validity period, the effective and expiration dates then click Next. Depending 
upon your needs, change the default validity period (10 years). 

2i Review the parameters sheet. If it is correct, click Finish. If it is incorrect, click Back until you 
reach the point where you need to make changes.

When you click Finish, a dialog box is displayed explains that a certificate has been created. 
This exports the certificate into the binary DER-format.

2j Download and save the issued certificate

3 Export the Organizational CA's self-signed certificate.

3a Log in to eDirectory from iManager.

3b From the Roles and Tasks menu, click Novell Certificate Server > Configure Certificate 
Authority.

This displays the property pages for the Organizational CA, which include a General page, 
a CRL Configuration page, a Certificates page, and other eDirectory-related pages.

3c Click Certificates, then select Self Signed Certificate.

3d Click Export.

This starts Certificate Export wizard.

3e Deselect the Export the Private Key option, and choose the export format as DER.

3f Click Next, then save the exported certificate.

3g Click Close.

You should now have the three files that you need to install ZENworks using an external CA.
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15 15Installing an External ZENworks 
Database

ZENworks requires two databases, one for general data and another for audit data. For these 
databases, you can use the embedded Sybase database software provided with ZENworks, or you 
can use a supported external database software (see Database Requirements). 

If you want to use the embedded database, skip the remainder of this section. You will install the 
embedded database during the installation of the ZENworks Primary Server software (see Installing 
the Primary Server Software).

 Section 15.1, “Prerequisites for External Databases,” on page 77

 Section 15.2, “Performing the External ZENworks Database Installation,” on page 80

15.1 Prerequisites for External Databases
Review the applicable sections:

 Section 15.1.1, “Prerequisites for Remote OEM Sybase,” on page 77

 Section 15.1.2, “Prerequisites for Remote Sybase SQL Anywhere,” on page 77

 Section 15.1.3, “Prerequisites for Microsoft SQL Server,” on page 78

 Section 15.1.4, “Prerequisites for Oracle,” on page 78

15.1.1 Prerequisites for Remote OEM Sybase

Before installing ZENworks 11 SP3 to create the Management Zone, you must install the remote 
OEM Sybase database on your remote database server so that it can be properly configured during 
installation of the Primary Server that hosts the database.

NOTE: For this database, Novell Support provides problem determination, provision of compatibility 
information, installation assistance, usage support, ongoing maintenance, and basic troubleshooting. 
For additional support, including extended troubleshooting and error resolution, see the Sybase 
Support web site (http://www.sybase.com/support).

15.1.2 Prerequisites for Remote Sybase SQL Anywhere

Before installing and configuring the Sybase SQL Anywhere database for ZENworks 11 SP3, ensure 
that the following prerequisites are met:

 Install and set up the Sybase SQL Anywhere database so that it can be updated during 
ZENworks installation.

 During ZENworks installation, you must specify a database user. Ensure that the database user 
has read/write permissions to create and modify the tables on the database server.
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NOTE: For this database, Novell Support provides problem determination, provision of compatibility 
information, installation assistance, usage support, ongoing maintenance, and basic troubleshooting. 
For additional support, including extended troubleshooting and error resolution, see the Sybase 
Support web site (http://www.sybase.com/support).

15.1.3 Prerequisites for Microsoft SQL Server

To use the Microsoft SQL Server database for ZENworks 11, ensure that the Microsoft SQL Server 
software is installed on the database server so that the ZENworks installation program can create the 
new Microsoft SQL database. For instructions on installing the Microsoft SQL Server software, refer 
to the Microsoft documentation.

For MS SQL, set the READ_COMMITTED_SNAPSHOT setting to ON so that it allows read access to 
information in the database while data is being written or modified.

To set the READ_COMMITTED_SNAPSHOT setting to ON, execute the following command at the 
database server prompt:

ALTER DATABASE database_name SET READ_COMMITTED_SNAPSHOT ON;

15.1.4 Prerequisites for Oracle

During the installation of the ZENworks database on Oracle, you can choose to create a new user 
schema or specify an existing one that resides on a server in your network.

 Create a new user schema: If you choose to create a new user schema, ensure that the 
following requirements are met:

 You must be aware of the database administrator credentials.

 A tablespace is needed for the Oracle access user. A tablespace is a storage location 
where the actual data underlying database objects can be kept. It provides a layer of 
abstraction between physical and logical data, and serves to allocate storage for all DBMS 
managed segments. (A database segment is a database object which occupies physical 
space such as table data and indexes.) Once created, a tablespace can be referred to by 
name when creating database segments.

 The tablespace can be created by ZENworks or can be created by the Database 
Administrator.

 The tablespace has sufficient space to create and store the ZENworks database schema. 
The tablespace requires a minimum of 10 GB to create ZENworks database schema.

 Use an existing user schema: You can install to an existing Oracle user schema that resides 
on a server in your network in the following scenarios:

 The database administrator creates a user schema with the necessary rights and you 
receive the credentials for that user schema from the database administrator. In this case, 
the database administrator credentials are not required to install to an existing Oracle user 
schema.

 You create a user schema in the Oracle database and choose to use it during ZENworks 11 
SP3 installation.
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If you choose to use an existing user schema, ensure that the following requirements are met:

 Ensure that the tablespace has sufficient space to create and store the ZENworks database 
schema. The tablespace requires a minimum of 10 GB to create ZENworks database 
schema.

 Ensure that the quota for the user schema is set to Unlimited on the tablespace that you 
plan to configure during the installation.

 Rights to create the database:  Ensure that the user schema has the following rights to create 
the database:

CREATE SESSION

CREATE_TABLE

CREATE_VIEW

CREATE_PROCEDURE

CREATE_SEQUENCE

CREATE_TRIGGER

ALTER ANY TABLE

DROP ANY TABLE

LOCK ANY TABLE

SELECT ANY TABLE

CREATE ANY TABLE

CREATE ANY TRIGGER

CREATE ANY INDEX

CREATE ANY DIMENSION

CREATE ANY EVALUATION CONTEXT

CREATE ANY INDEXTYPE

CREATE ANY LIBRARY

CREATE ANY MATERIALIZED VIEW

CREATE ANY OPERATOR

CREATE ANY PROCEDURE

CREATE ANY RULE

CREATE ANY RULE SET

CREATE ANY SYNONYM

CREATE ANY TYPE

CREATE ANY VIEW

DBMS_DDL

DBMS_REDEFINITION

IMPORTANT: For Oracle databases, performance can be affected by whether you configure 
your database to use shared server or dedicated server processes. Each ZENworks Primary 
Server is configured with a database connection pool whose size fluctuates with the ZENworks 
system load. This pool can grow at peak loads to a maximum of 100 concurrent database 
connections per Primary Server. If your Oracle database is configured to use dedicated server 
processes, it is possible that your database server resource usage can reach undesirable levels 
that affect performance when there are multiple Primary Servers in your zone. If you encounter 
this problem, consider changing your ZENworks database to use shared server processes.

Prerequisites for Oracle RAC

 Oracle database and Real Application Clusters (RAC) version must be 11.2.0.4 or above.
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 Tablespaces must be created by your database administrator manually (do not use ZENworks to 
create the tablespaces).

 Shut down ZENworks services on all Primary Servers and Reporting Server before upgrading  
ZENworks.

15.2 Performing the External ZENworks Database 
Installation
This section provides instructions for installing the ZENworks database by running the ZENworks 
installation program on the database server. This method is required if you are using a remote OEM 
Sybase database. For other databases, this method is useful if your ZENworks administrator and 
database administrator are not the same person.

You can also install your external ZENworks database when you install the ZENworks Primary Server 
software on the target Linux server. If you want to use this method, skip this section and go to 
Chapter 16, “Installing a ZENworks Primary Server on Linux,” on page 89.

Ensure that the server where you plan to install the external database fulfills the requirements in 
Chapter 2, “Database Requirements,” on page 15 and “Prerequisites for External Databases” on 
page 77.

1 On the server where you want to install the external database, insert the Novell ZENworks 11 
SP3 installation DVD. If the DVD autoruns the database installation program, exit the program.

Run the following command on the external database server:

sh /media/cdrom/setup.sh -c

This provides additional options that you do not have when installing the Primary Server, 
especially if you want to make your OEM database a remote database. You can view the SQL 
files generating the ZENworks database, create access users, view creation commands (OEM 
Sybase only), and so on. Only GUI installation is available for installing ZENworks and audit 
database instances using the -c option.

or

If ZENworks 11 SP3 has already been installed on a device, and if you want to use the device to 
configure another instance of the ZENworks database (on the same device or on another 
device) by using the external database installation program, run the following command:

mounted_DVD_drive/setup.sh -c --zcminstall

Using the sh command resolves rights issues.

2 On the Select ZENworks Database page, select one of the following:

 Select ZENworks Database

 Select Audit Database 

 Select both ZENworks Database and Audit Database

NOTE: When the ZENworks Database and Audit Database option is selected, you need to 
create the ZENworks database first and then create the audit database.

The supported combinations of ZENworks and Audit database are shown below: 
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3 On the Select Database type page, select one of the following, then click Next:

 OEM Sybase SQL Anywhere: Installs the default Sybase database for ZENworks. It is 
configured as a service, the database user is created, and the required tables for the 
Primary Server are established.

You must also select the Remote Sybase SQL Anywhere option during installation of the 
Primary Server.

 External Sybase SQL Anywhere: Sets up an existing Sybase database for writing 
ZENworks information to it.

 Microsoft SQL Server: Creates a ZENworks database on a Microsoft SQL Server.

 Oracle: Specifies a user schema that you can use to set up an external Oracle database 
schema for use with ZENworks.

IMPORTANT: The server hosting the database must have time synchronization with all of the 
Primary Servers in the Management Zone.

4 Refer to the following information for details on the installation data that you need to know (you 
can also click the Help button for similar information):

 “OEM Sybase SQL Anywhere Database Installation Information” on page 81

 “Sybase SQL Anywhere Database Installation Information” on page 83

 “MS SQL Database Installation Information” on page 84

 “Oracle Database Installation Information” on page 87

15.2.1 OEM Sybase SQL Anywhere Database Installation 
Information

ZENworks Database Audit Database

OEM Sybase SQL Anywhere  OEM Sybase SQL Anywhere (Default)

 External Sybase SQL Anywhere

External Sybase SQL Anywhere  External Sybase SQL Anywhere (Default)

 OEM Sybase SQL Anywhere 

Microsoft SQL Server Microsoft SQL Server

Oracle Oracle

Installation 
Information

Explanation

Sybase Database 
Installation

Specify the path where you want to install the OEM copy of the 
Sybase SQL Anywhere database software. On the target server, 
only the drives that are currently mapped on the server are 
available.

The default path is drive:\novell\zenworks, which you can 
change. The installation program creates the \novell\zenworks 
directory for the installation of Sybase.
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Sybase Server 
Configuration

Specify the port used by the Sybase SQL Anywhere database 
server. By default, port 2638 is used for the ZENworks database 
and port 2639 is used for the Audit database. Change the default 
port number if you have a conflict.

Sybase Access 
Configuration

Defaults are provided for some of the information, which you can 
change as necessary.

 Database Name: Specify a name for the database to be 
created.

 Username: Specify a name to create a new user who can 
access the database.

 Password: Specify the password to be used to the access 
the database.

 Database Server Name: Specify a name for the Sybase SQL 
Anywhere database server.

Database File 
Location

Specify the path where you want to create the ZENworks Sybase 
database file. By default, the installation program creates the 
drive:\novell\zenworks directory, which you can change. A 
\database directory is appended to the default directory. 

For example,. the default path is 
drive:\novell\zenworks\database.

Review Database 
Information

Review the database configuration information. 

The Server Address field displays the IP address configured in the 
hosts file. This does not impact the database installation. The 
hosts file is located in the /etc/ directory on a Linux device.

The database driver information is automatically detected by the 
ZENworks database installer. 

Review SQL 
Scripts

Review the SQL scripts to be executed during the database 
creation.

Review Database 
Creation 
Command

Review the commands used to create the database.

NOTE: Ensure that the ports used for ZENworks database and 
Audit database are included in firewall exception list. Run the 
following command:

iptables -I INPUT -p tcp --dport PORT--syn -j 
ACCEPT

Where PORT: By default it is 2638 for ZENworks and 2639 for Audit 
or any alternate port number that is configured. This command has 
to be executed separately for ZENworks database port and Audit 
database port. 

service iptables save

service iptables restart

Installation 
Information

Explanation
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15.2.2 Sybase SQL Anywhere Database Installation Information

Installation 
Information

Explanation

Sybase Server 
Configuration

 Server name: We recommend that you identify the server by 
its DNS name rather than its IP address, to be in sync with 
certificates that are signed with DNS names.

IMPORTANT: If you change your database server’s IP address 
or DNS name at a later time, ensure that your corporate DNS 
server is updated with this change to keep DNS for the 
database server in sync.

 Port: Specify the port used by the Sybase SQL Anywhere 
database server. The default is port 2638. For the Audit 
database, the default is port 2639. Change the default port 
number if you have a conflict.

Sybase Access 
Configuration

This server must have a Sybase SQL Anywhere database installed. 
Defaults are provided for some of this information, which can be 
changed as necessary.

 Database Name: Specify the name of the existing database

 Username: Specify the user who can modify the database. The 
user must have read/write permissions to modify the database.

 Password: Specify the password of an existing user with read/
write permissions to the database.

 Database Server Name: Specify the name of your Sybase 
SQL Anywhere database server.

Review Database 
Information

Review the database configuration information.

The database driver information is automatically detected by the 
ZENworks Database installer.

Review SQL 
Scripts

Review the SQL scripts to be executed during the creation of the 
database.

Review Database 
Creation 
Commands

Review the database commands used to create the database.
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15.2.3 MS SQL Database Installation Information
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Installation 
Information

Explanation

External Database 
Server 
Configuration

The database server must have an MS SQL database installed. 
Defaults are provided for some of this information, which can be 
changed as necessary:

 Server Address: We recommend that you identify the server 
by its DNS name rather than its IP address, to be in sync with 
certificates that are signed with DNS names.

IMPORTANT: If you change your database server’s IP 
address or DNS name at a later time, ensure that your 
corporate DNS server is updated with this change to keep 
DNS for the database server in sync.

 Port: Specify the port used by the MS SQL database server. 
The default is port 1433. Change the default port number if 
you have a conflict.

 Named instance: This is the name of the SQL server 
instance that is hosting the existing ZENworks database. You 
must specify the named instance if you want it to be 
something other than the default of mssqlserver.

 Database Name: Specify the name of the existing MS SQL 
database on which you want to host the ZENworks database. 
This option is available only for an existing database.

 Username: Specify the user who can modify the database. 
The user must have read/write permissions to modify the 
database.

NOTE:  Ensure that the special character ' is not part of the 
database name.

For Windows authentication, provide a user name on the 
current device or in the domain. 

IMPORTANT

The installer wizard continues without validating the 
credentials; therefore, ensure that the correct credentials are 
provided. Else, the installation might fail towards the end of the 
installation process.

For SQL authentication, provide a user name that matches 
that of a valid SQL user.

If both ZENworks database and audit database are created on 
the same machine then, ensure that ZENworks database 
users and audit database user are not the same.

 Password: Type the password of the user specified in the 
Username field.

 Domain: It is important to know whether you installed the SQL 
Server by using SQL authentication, Windows authentication, 
or mixed. Ensure that you select the option that coincides with 
your SQL Server options; otherwise, the authentication will 
fail. 

If you are using MS SQL with Windows Authentication, the 
host name (not FQDN) of Active Directory is used.

If you are using Windows authentication, specify the Windows 
domain where the user you specified in the Username field 
exists. If you are not using a Windows domain, specify the 
server’s short name.
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15.2.4 Oracle Database Installation Information

External Database 
Configuration > 
Database Location 
(applicable only for 
the new database)

Specify the path of the existing MS SQL database file on the SQL 
server. By default, it is c:\database. 

NOTE: Ensure that the specified path exists on the device hosting 
the database before the installation starts.

Review Database 
Information

Review the database configuration information.

Review SQL 
Scripts

Review the SQL scripts to be executed during the creation of the 
database. You can only view the scripts.

Installation 
Information

Explanation

Installation 
Information

Explanation

Oracle User 
Schema Options

You can either create a new user schema or specify an existing one 
that resides on a server in your network. You can use the user 
schema to set up an external Oracle database schema for use with 
ZENworks.

If you are creating a new user schema, a tablespace must already 
exist for associating to the Oracle access user. In an existing user 
schema, the rights and tablespace must already be set up.

Oracle Server 
information

The database server must have an Oracle database installed. 
Defaults are provided for some of this information, which can be 
changed as necessary.

 Server Address: We recommend that you identify the server 
by its DNS name rather than its IP address, to be in sync with 
certificates that are signed with DNS names.

IMPORTANT: If change your database server’s IP address or 
DNS name at a later time, ensure that your corporate DNS 
server is updated with this change to keep DNS for the 
database server in sync.

 Port: Specify the port used by the database server. The 
default is port 1521. Change the default port number if you 
have a conflict.

 Service Name: For a new user schema, specify the instance 
name (SID) on which the user schema is to be created. For an 
existing user schema, specify the instance name (SID) on 
which the user schema has been created.

Oracle 
Administrator 
(applicable only 
for the new user 
schema)

 Username:  Specify the user who can modify the database. 
The user must have read/write permissions to modify the 
database.

 Password: Specify the password to be used to the access the 
database.
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Oracle Access 
User

 Username: For a new user schema, specify a name. For an 
existing user schema, specify the name of the user schema 
that already exists in the Oracle database.

 Password: For a new user schema, specify a password to be 
used to access the database. For an existing user schema, 
specify the password used to access the user schema that 
already exists in the Oracle database. 

 Tablespace: For a new user schema, select one of the 
following tablespace options:

 Let ZENworks create the tablespace: Select this if you 
want ZENworks to create the tablespace.

 Let DBA create the tablespace: Select this if you want 
your database administrator to create the tablespace. 

The following details are required to create a new 
tablespace:

IMPORTANT: If you are using Automatic Storage 
Management

(ASM) or some other Disk storage, select Let DBA create 
the tablespace.

 Tablespace name for Tables (Ensure t name is 
unique and it should start with [a-z] | [A-Z].Oracle 
tablespace naming convention has to be followed.)

 Tablespace name for Indexes (Ensure Tablespace 
name is unique and it should start with [a-z] | [A-
Z].Oracle tablespace naming convention has to be 
followed.)

 DBF File location for Tables

 DBF File location for Indexes (The specified 
physical path of the DBF file should be an existing 
path. The file name must have the .dbf extension.)

Review Database 
Information

Review the database configuration information.

Review SQL 
Scripts

Review the SQL scripts to be executed during the creation of the 
database.

Installation 
Information

Explanation
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16 16Installing a ZENworks Primary Server on 
Linux

Perform the tasks in the following sections to install the ZENworks 11 SP3 software:

 Section 16.1, “Installing the Primary Server Software,” on page 89

 Section 16.2, “Performing an Unattended Installation,” on page 90

 Section 16.3, “Verifying the Installation,” on page 92

 Section 16.4, “Installation Information,” on page 93

16.1 Installing the Primary Server Software
 Section 16.1.1, “Using the Graphical User Interface (GUI) Installation Program to Install the 

Primary Server Software,” on page 89

 Section 16.1.2, “Using the Command Line Interface (CLI) Installation Program to Install the 
Primary Server Software,” on page 89

16.1.1 Using the Graphical User Interface (GUI) Installation 
Program to Install the Primary Server Software

1 Log in to the installation server as a Linux administrator.

2  Insert the Novell ZENworks 11 SP3 installation DVD.

3 Mount the DVD, then run sh /media/cdrom/setup.sh. 

Using the sh command resolves rights issues.

When installing ZENworks 11 SP3, Strawberry Perl is installed in the root directory to meet the 
Perl runtime requirement for the ppkg_to_xml tool that should run on both Windows and Linux. 
This tool is required to read the RPM package files to extract the package metadata and to 
create Linux bundles or Dependency bundles with these packages.

4 During installation, refer to the information in Section 16.4, “Installation Information,” on page 93 
for details on the installation data that you need to know.

NOTE: Part of completing the installation process is for the database to be updated and for the 
Product Recognition Update (PRU) to be downloaded and installed, both of which cause high 
CPU utilization during their processes. This can cause the services to start up slowly, which can 
also affect how long it takes for ZENworks Control Center to open.

16.1.2 Using the Command Line Interface (CLI) Installation 
Program to Install the Primary Server Software

1 Log in to the installation server as a Linux administrator.

2 Insert the Novell ZENworks 11 SP3 installation DVD.
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This cannot be in /root or any directory under it.

3 Mount the DVD to a directory where all (including “others”) have read and execute access. Either 
mount the DVD or copy the DVD’s files.

If you copy the DVD's files, ensure that all (including “others”) continue to have read and execute 
access to the destination directories.

4 To start the installation, run the following command:

sh /mount_location/setup.sh -e

IMPORTANT: When you use the -e option to execute a Linux CLI installation, the next, back, 
and quit keywords cannot be used as input, because the configuration framework interprets 
these keywords as commands.

5 During installation, refer to the information in Section 16.4, “Installation Information,” on page 93 
for details on the installation data that you need to know.

16.2 Performing an Unattended Installation
You can use a response file to perform an unattended installation of ZENworks 11 SP3. You can 
either edit the default response file (provided at 
DVD_drive:\Disk1\InstData\silentinstall.properties), or perform an installation to create 
your own version of the response file that contains the basic installation information and edit that copy 
as needed.

For an embedded Sybase database, you must create a response file to perform an unattended 
installation; you cannot reuse the response file generated for a server that uses an external database.

Do the following to create the response file, and then use it to perform an unattended installation:

 Section 16.2.1, “Creating Your Response File,” on page 90

 Section 16.2.2, “Performing the Installation,” on page 92

16.2.1 Creating Your Response File

1 Run the ZENworks 11 SP3 installation executable on a server by using one of the following 
methods:

 Linux GUI: sh /media/cdrom/setup.sh -s

Using the sh command resolves rights issues.

 Linux command line: sh /media/cdrom/setup.sh -e -s

For more information on the installation arguments, see “Installation Executable Arguments” on 
page 107.

2 When prompted, provide a path for your custom response file.

When you use the -s argument by itself, the installation program prompts you for a path for the 
response file. The default file name is silentinstall.properties, which you can rename later 
(see Step 3f).

3 Add the Management Zone and external database passwords to your custom response file.

Because the external database password that you enter during creation of the custom response 
file is not saved in the response file, you must add the database and the Management Zone 
passwords in each copy of the response file in order for it to be correctly provided during an 
unattended installation. 
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Optionally, you can create an environment variable to pass the password into the unattended 
installation. Instructions for this are contained in the response file where the password 
information is stored.

While you are editing the response file, you can make any other changes necessary to 
customize it for your unattended installation. The response file contains instructions for its 
various sections.

To add the external database and Management Zone passwords into the response file:

3a Open the response file in a text editor.

Your custom response file is in the location that you specified in Step 2.

If you are editing the default response file, it is located at 
DVD_drive:\Disk1\InstData\silentinstall.properties.

3b Search for ADMINISTRATOR_PASSWORD=.

3c Replace $lax.nl.env.ADMIN_PASSWORD$ with the actual password.

For example, if the password is novell, the entry will be

ADMINISTRATOR_PASSWORD=novell

3d (Conditional) If you are using an external database, search for the line 
DATABASE_ADMIN_PASSWORD=, and replace $lax.nl.env.ADMIN_PASSWORD$ with the actual 
password.

3e (Conditional) If you are using an external database, search for the line 
DATABASE_ACCESS_PASSWORD=, and replace $lax.nl.env.ADMIN_PASSWORD$ with the 
actual password.

3f If you want to add another Primary Server to the existing Management Zone, you must 
provide the following information in the response file:

PRIMARY_SERVER_ADDRESS=$Primary_Server_IPaddress$

PRIMARY_SERVER_PORT=$Primary_Server_port$

PRIMARY_SERVER_CERT=-----BEGIN CERTIFICATE-----
MIID9DCCLotsOfEncryptedCharactersSja+bY05Y=-----END CERTIFICATE-----

where

PRIMARY_SERVER_ADDRESS is the IP address or DNS name of the parent Primary 
Server if the secondary server is being installed to an existing Management Zone.

PRIMARY_SERVER_PORT is the SSL port used by the parent Primary Server if the 
secondary server is being installed to an existing Management Zone. The default port is 
443.

PRIMARY_SERVER_CERT= is the certificate you specified on the parent Primary Server if 
the secondary server is being installed to an existing Management Zone. The certificate 
must be in the base64 encoded string format of an x509 certificate, and the certificate string 
must be specified in one line. This is just an example of the certificate information. 

3g Save the file and exit the editor.

4 After you have completed modifications to your custom response file, copy it from the path that 
you specified in Step 2 to a location on each server where you will use it for the unattended 
installation.

5 To use the updated response file, continue with Section 16.2.2, “Performing the Installation,” on 
page 92.
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16.2.2 Performing the Installation

1 On the installation server where you will perform an unattended installation, insert the Novell 
ZENworks 11 SP3 installation DVD and mount it.

2 To start the unattended installation, run the following command:

 sh /media/cdrom/setup.sh -s -f path_to_file.

where path_to_file is either the full path to the response file that you created in Section 16.2.1, 
“Creating Your Response File,” on page 90, or a directory containing the 
silentinstall.properties file (it must use that file name).

Using the sh command resolves rights issues.

If you renamed the updated response file, include its new name with the path.

If a file name is not given, or if either the path or file does not exist, the -f parameter is ignored 
and the default installation (GUI or command line) is run instead of an unattended installation.

3 To create another Primary Server for the Management Zone by performing an unattended 
installation, return to Step 1; otherwise, continue with Step 4.

4 After the installation has completed, continue with Section 16.3, “Verifying the Installation,” on 
page 92.

16.3 Verifying the Installation
Perform the following steps if you want to verify a successful installation.

1 After the installation has completed and the server has been rebooted, do any of the following to 
verify that ZENworks 11 SP3 is running:

 Run ZENworks Control Center 

If ZENworks Control Center did not automatically start, use the following URL to open it in a 
web browser:

https://DNS_name_or_IP_address_of_Primary_Server/zenworks

NOTE: If the Primary Server is not using the default HTTPS port, you must add the port to 
the URL: https://DNS_name_or_IP_address_of_Primary_Server:port_number/zenworks

This can be done either on the server where you just installed ZENworks, or on a qualified 
workstation.

 Check the Linux services by using the configuration command 

On the server, run the following command:

/opt/novell/zenworks/bin/novell-zenworks-configure -c SystemStatus

This lists all ZENworks services and their statuses.

To start the services, run the following command:

/opt/novell/zenworks/bin/novell-zenworks-configure -c Start

 Check the Linux services by using the specific services’ commands 

On the server, run the following commands:

/etc/init.d/novell-zenserver status

/etc/init.d/novell-zenloader status
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If the services are not running, run the following commands to start the ZENworks services:

/etc/init.d/novell-zenserver start

/etc/init.d/novell-zenloader start

16.4 Installation Information

Installation 
Information

Explanation

Installation path Several fixed installation paths are used:

/opt/novell/zenworks/

/etc/opt/novell/zenworks

/var/opt/novell/zenworks

/var/opt/novell/log/zenworks/

If you are concerned about disk space on the Linux server, the /var/opt directory is 
where the database and content repository reside. 

Response file 
path (optional)

If you started the installation executable with the -s parameter, you are required to 
provide a path for the file. The default path is /root, which you can change to any 
path available on the current server.

The Primary Server software is not installed when you run the program to create a 
response file. It only displays the installation pages necessary to identify and create 
the response file.

Prerequisites If the required prerequisites are not installed, you are not allowed to continue with the 
installation. The requirements that are not fulfilled are displayed (GUI) or listed 
(command line). For more information, see “Prerequisites for Remote Sybase SQL 
Anywhere” on page 77.

If the .NET prerequisite is not fulfilled, you can click the ZENworks link in the 
description to install the runtime version that is bundled with ZENworks. After .NET is 
installed, the installation of ZENworks proceeds. This wizard might take a few 
seconds to launch.
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Management 
Zone

New Zone: If you are installing to the first server in the zone, you need to know the 
name and password you want to use for the Management Zone. The password is 
used to log in to ZENworks Control Center.

Zone Name: The zone name has a 20-character limit and should be a unique name. 
The zone name can contain only the following special characters: - (dash) _ 
(underscore) . (period). The zone name cannot contain special characters such as ~ .  
` ! @ # % ^ & * + = ( ) { } [ ] | \ : ; " ' < > , ? / $

For Embedded Sybase, ensure that the zone name is unique in your environment.

IMPORTANT: While installing ZENworks in a non-English language operating 
system, ensure that the Management Zone name does not use special characters 
from any other non-English language.For example, while installing ZENworks on a 
simplified Chinese operating system, ensure that the Zone name does not use "üöä" 
from the German Character Set.

Zone Password: By default, the login user name is Administrator. After 
completing the installation, you can use ZENworks Control Center to add other 
administrator names that can be used to log in to the Management Zone. The zone 
administrator password must contain at least six characters and is limited to a 
maximum of 255 characters. The password can contain only one instance of the $ 
character.

Port Number: During the installation of subsequent Primary Servers, the server by 
default uses the ports used by first Primary Server. If the ports are in use on the 
second Primary Server, you are asked to specify another port. Note which port you 
specify because you will need to use it in the URL for accessing ZENworks Control 
Center from that Primary Server.

Existing Zone: If you are installing to an existing Management Zone, you need to 
know the following information:

 The DNS name or IP address of an existing Primary Server in the zone. We 
recommend using the DNS name to provide ongoing synchronization with 
certificates that are signed with DNS names.

 The SSL port used by the existing Primary Server in the Management Zone. If 
the Primary Server uses a different port than the default (443), specify that port.

 A ZENworks administrator user name to log in to the zone. The default is 
Administrator. After completing the installation, you can use ZENworks 
Control Center to add other administrator names that can be used to log in to the 
Management Zone.

 The password for the administrator you specified in the Username field.

Database 
Configuration 
Recommendatio
n

You can enter the number of devices used in thousands. For example enter 1 for 
1000 devices, 2 for 2000, and so on.The range of devices is between 1 to 100. Based 
on the number of devices, the database recommendation is displayed.

Installation 
Information

Explanation
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Database options ZENworks requires a database. The database options are displayed only when 
installing the first Primary Server to the zone. 

You have the following database options:

 Embedded Sybase SQL Anywhere: Automatically installs the embedded 
database on the local server.

If you select the embedded database option, no further database installation 
pages are shown.

 Remote Sybase SQL Anywhere: This database must already exist on a server 
in your network. It can be on the current server.

To select this option, you should already have followed the steps in 
“Prerequisites for Remote Sybase SQL Anywhere” on page 77.

You also use this option for installing to an existing remote OEM Sybase 
database.

 Microsoft SQL Server: You can create a new SQL database or specify an 
existing database that resides on a server in your network. It can be on the 
current server.

Creating a new SQL database at this time provides the same results as the 
steps in “Prerequisites for Microsoft SQL Server” on page 78.

 Oracle: Specifies a user schema that you can use to set up an external Oracle 
database schema for use with ZENworks.

You can either create a new user schema or specify an existing one that resides 
on a server in your network.

To select this option, you should already have followed the steps in 
“Prerequisites for Oracle” on page 78.

IMPORTANT: The following points must be considered for external databases:

 The time on the server hosting the database must be synchronized with each of 
the Primary Servers in the Management Zone. The external database can also 
reside on the Primary Server machine.

 If you have specified the database hostname, it must be DNS resolvable.

Installation 
Information

Explanation
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Database 
information

For the external database options (Remote Sybase SQL Anywhere, Microsoft SQL 
Server, and Oracle), you need to know the information listed below. Defaults are 
provided for some of this information, which can be changed as necessary.

 All Databases: The database server must have a Sybase SQL Anywhere, 
Microsoft SQL, or Oracle database installed.

 Server’s name. We recommend that you identify the server by its DNS 
name rather than its IP address, to be in sync with certificates that are 
signed with DNS names.

IMPORTANT: If you later change your database server’s IP address or 
DNS name, ensure that your corporate DNS server is updated with this 
change to keep DNS for the database server in sync.

 Port used by the database server.

Port 2638 is the default for Sybase SQL Anywhere and port 1433 is the 
default for Microsoft SQL Server.

Change the default port number if you have a conflict.

 (Optional) SQL Server Only: Named instance that is the name of the SQL 
server instance that is hosting the existing ZENworks database. You must 
specify the named instance if you want it to be something other than the default 
of mssqlserver.

 Oracle Only: The name of the tablespace where you want the database to be 
created. The default is USERS.

 New Database: 

 The database administrator (Username field) must have read/write 
permissions in order to successfully perform the required operations on the 
database.

 The administrator’s database password.

 SQL Server or New Database: 

 If you are using Windows authentication, specify the Windows domain 
where the user you specified in the Username field exists. If you are not 
using a Windows domain, specify the server’s short name.

 Whether to use Windows or SQL Server authentication. For Windows 
authentication, provide the credentials for a user on the current device or in 
the domain. For SQL authentication, provide credentials that match those 
of a valid SQL user.

It is important to know whether you installed the SQL Server by using SQL 
authentication, Windows authentication, or mixed. Be sure to select the option 
that coincides with your SQL Server options; otherwise, the authentication will 
fail.

Installation 
Information

Explanation
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Database access For the external database options (Remote Sybase SQL Anywhere, Microsoft SQL 
Server, and Oracle), you need to know the information listed below. Defaults are 
provided for some of this information, which can be changed as necessary.

 All Databases: This server must have a Sybase SQL Anywhere, Microsoft 
SQL, or Oracle database installed.

 Database name. Replace zenworks_MY_ZONE with either the desired 
database name or an existing database name.

 Database user name. This user must have read/write permissions to 
modify the database.

If Windows authentication is also selected, the specified user must already 
exist when you create a new SQL database. The user is granted login 
access to SQL Server and read/write access to the ZENworks database 
that is created.

For an existing database, specify a user with sufficient permissions to the 
database.

 Database password. For a new database, this password is automatically 
generated if SQL authentication is selected. For an existing database, 
specify the password of an existing user with read/write permissions to the 
database.

 Sybase Databases Only: The name of your Sybase SQL Anywhere database 
server.

 Oracle Databases Only: The name of the tablespace where you want the 
database to be created. By default, it is USERS.

 Microsoft SQL Databases Only: 

 If you are using Windows authentication, specify the Windows domain 
where the user you specified in the Username field exists. If you are not 
using a Windows domain, specify the server’s short name.

 Whether to use Windows or SQL Server authentication. For Windows 
authentication, provide the credentials for a user on the current device or in 
the domain. For SQL authentication, provide credentials that match those 
of a valid SQL user.

It is important to know whether you installed the SQL Server by using SQL 
authentication, Windows authentication, or mixed. Be sure to select the option 
that coincides with your SQL Server options; otherwise, the authentication will 
fail.

SSL 
configuration 
(shown only for 
the first server 
installed in the 
Management 
Zone)

In order to enable SSL communications, an SSL certificate must be added to the 
ZENworks server. Select whether to use an internal or external certificate authority 
(CA).

For subsequent installations of Primary Servers to the Management Zone, the CA 
established by the first server’s installation is used for the zone.

IMPORTANT: After you install ZENworks 11 SP3, you can only change the internal 
certificate to an external certificate on Primary Servers. For more information, see 
“Reconfiguring a Zone Certificate Before It Expires”in the ZENworks 11 SP3 Disaster 
Recovery Reference.

The Restore Default buttons restore the paths to those that were displayed when you 
first accessed this page.

Installation 
Information

Explanation
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Signed SSL 
certificate and 
private key

To enter a trusted CA-signed certificate and private key, click Choose to browse for 
and select the certificate and key files, or specify paths to the signed certificate to be 
used for this server (Signed SSL Certificate) and the private key associated with the 
signed certificate (Private Key).

For subsequent installations of Primary Servers to the zone, the CA established for 
the zone by the first server’s installation is used. If the zone is using an internal CA, 
you must provide the IP address or DNS name of the Primary Server with CA role. 
Otherwise, the wizard will not proceed further.

For information on creating external certificates to select when installing to a Linux 
server, see Section 15, “Installing an External ZENworks Database,” on page 77.

For information on creating external certificates for installing to a server using a silent 
installation, see Section 16.2.1, “Creating Your Response File,” on page 90.

Root certificate 
(optional)

To enter a trusted CA root certificate, click Choose to browse for and select it, or 
specify the path to the CA’s public X.509 certificate (CA Root Certificate).

Pre-installation 
summary

GUI Installation: To make changes to any information entered up to this point, click 
Previous. After you click Install, the installation of the files begins. During installation, 
you can click Cancel to stop, which leaves the files on your server that were installed 
up to that point.

Command Line Installation: If you want to make changes to any information 
entered up to this point, you can type back and press Enter as many times as 
necessary. As you progress forward through the commands again, press Enter to 
accept the decisions that you previously made.

Installation 
complete (roll 
back option)

If installation errors occurred, this page is displayed at this time; otherwise, it is 
displayed after the Post-Installation Actions page.

Installation Recovery: For both the GUI and command line installations, if there are 
serious installation errors, you can roll back the installation to return your server to its 
previous state. This option is provided on a different installation page. Otherwise, you 
have two options:

 If a previous installation was cut short and you install again, you might be given 
the option to reset the installation, depending on how far you got in the canceled 
installation. If you select to reset, this overwrites any configuration that might 
have occurred during the canceled installation.

 To undo a successfully completed installation, follow the instructions in the 
ZENworks 11 SP3 Uninstall Guide.

If there were serious installation errors, select Roll Back, which returns your server to 
its previous state. Upon exiting the installation program, the server is not rebooted. 
However, to complete the installation, you must reboot the server.

To determine whether to continue the installation or roll it back, review the log file that 
lists the errors to determine if any installation failures were significant enough for your 
action. If you select to continue, resolve the issues that are noted in the log after you 
have rebooted the server and completed the installation process.

To access the log file in the GUI installation, click View Log. In the command line 
installation, the path to the log file is displayed.

Installation 
Information

Explanation
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Post installation 
actions

Options are presented for selecting actions to perform after the installation has 
successfully completed:

 For the GUI installation, a page displays the options listed below. Some items 
are selected by default. Click any check box to select or deselect the option, 
then click Next to continue.

 For a command line installation, the options are listed with option numbers. 
Select or deselect an option by typing its number to toggle its selection status. 
After configuring the selections, press Enter without typing a number to 
continue.

Select from the following possible actions:

 Run ZENworks Control Center: Opens ZENworks Control Center immediately 
if you select to reboot manually or you installed to a Linux server. For a Linux 
installation without a GUI, a GUI-enabled device must be used to run ZENworks 
Control Center.

For the Oracle database, the administrator names are case sensitive. The 
default ZENworks administrator account that was automatically created during 
installation uses an initial capital letter. In order to log in to ZENworks Control 
Center, you must enter Administrator.

 View Readme file: For GUI installations, it opens the ZENworks 11 SP3 
Readme in your default browser. For a Linux command line installation, the URL 
to the Readme is listed.

 View Installation log: Displays the installation log in your default XML viewer 
(GUI installation) after rebooting, or immediately if you select to reboot manually. 
For a Linux command line installation, the information is simply listed.

ZENworks 
System Status 
Utility

Allows you to launch a ZENworks services heartbeat check prior to closing the 
installation program. Results are posted in the installation log.

Rebooting (or 
not)

Upon a successful installation, you can select between rebooting immediately or later:

 Yes, Restart the System: If you select this option, log in to the server when 
prompted. The first time you log in to the server, it takes a few minutes because 
the database is being populated with inventory data.

 No, I Will Restart the System Myself: If you select this option, the database is 
immediately populated with inventory data.

NOTE: This option is displayed only for Windows devices.

The process of populating the database can cause high CPU utilization during a 
reboot or immediately after the installation program closes if you select not to reboot. 
This database updating process can slow down the starting of the services and 
access to ZENworks Control Center.

The Patch Management downloads might also cause high CPU utilization, usually 
shortly after rebooting.

Installation 
Information

Explanation
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Installation 
completion

The actions you selected previously are performed after all of the files have been 
installed for ZENworks 11 SP3 (if selected).

IMPORTANT: If you installed to a Linux server using the command line, and if you 
plan to run any zman commands in the current session, you need to get the newly 
installed /opt/novell/zenworks/bin directory into your session’s path. Log out 
of your session and log back in to reset the PATH variable.

Installation 
Information

Explanation
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17 17Completing Post-Installation Tasks

After successfully installing the ZENworks Primary Server software, you might need to perform some 
of the following post-installation tasks. Not all tasks are required for all installations. However, we 
recommend that you review each section to ensure that you complete any tasks required for your 
installation. 

 Section 17.1, “Licensing Products,” on page 101

 Section 17.2, “Adding Imaging Applications as Firewall Exceptions,” on page 102

 Section 17.3, “Supporting ZENworks 10.3.4 Device Upgrades,” on page 102

 Section 17.4, “Backing Up ZENworks Components,” on page 102

 Section 17.5, “Customizing ZENworks Control Center,” on page 103

 Section 17.6, “Tasks for VMware ESX,” on page 103

17.1 Licensing Products 
During the installation of your first ZENworks Primary Server and the creation of your Management 
Zone, the ZENworks installation program installs the following products and sets their license state as 
listed in the table.

You activate a product by supplying a valid product license. If you do not have a valid license, you can 
evaluate the product for 60 days. 

To change the license state of a product:

1 Log in to ZENworks Control Center.

2 Click Configuration.

3 In the Licenses panel, click a suite if you have a suite license key.

or

Click a product to provide a product license key or to turn on the product evaluation.

For more information, see the ZENworks 11 SP3 Product Licensing Reference.

Product License State

Asset Inventory for UNIX/Linux Evaluation

Asset Inventory for Windows/Mac Deactivated

Asset Management Evaluation

Configuration Management Evaluation

Endpoint Security Management Deactivated

Full Disk Encryption Deactivated

Patch Management Activated
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17.2 Adding Imaging Applications as Firewall 
Exceptions
The ZENworks installation program cannot add exceptions to a Linux server firewall. Therefore, you 
must manually complete this task under the following conditions:

 The Primary Server will be an Imaging Server.

 The Primary Server will be the parent Primary Server of an Imaging Satellite Server. 

If you turn on the firewall on the Primary Server, you must configure the server to allow the following 
ZENworks 11 SP3 Configuration Management Imaging applications through the firewall by adding 
them to the Firewall Exceptions list:

 novell-pbserv.exe

 novell-proxydhcp.exe

 novell-tftp.exe

 novell-zmgprebootpolicy.exe

NOTE

After installing the server on Linux device, /opt/novell/zenworks/bin is not added to the PATH 
variable; therefore, the commands in that directory cannot be used directly. Do any of the following on 
the Linux device to run the commands from /opt/novell/zenworks/bin:

 Log in to the device again.

 Specify the complete path to access the command. 

For example: /opt/novell/zenworks/bin/zac

17.3 Supporting ZENworks 10.3.4 Device Upgrades
If you have ZENworks 10.3.4 managed devices or Satellite Servers in your network and want to 
register the devices to a new ZENworks 11 SP3 Management Zone so that they can be automatically 
upgraded to ZENworks 11 SP3, you must import the ZENworks 11 SP3 System Update into the zone 
from the ZENworks 11 SP3 installation media. For detailed information, see TID 7007958 in the 
Novell Support Knowledge base (http://support.novell.com/search/kb_index.jsp).

17.4 Backing Up ZENworks Components
We recommend that you implement the following backup best practices:

 Take a reliable backup of the ZENworks database and Audit database on a regular basis. For 
more information on how to back up the ZENworks database, see the ZENworks 11 SP3 
Database Management Reference.

 Procure and note down the credentials of the database.

 For an internal database, use the following commands: 

zman dgc -U administrator_name -P administrator_password

 For the embedded Sybase audit database, use the following commands: 
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zman dgca -U admimistrator_name -P administrator_password

 For an external database, contact the database administrator.

 Take a reliable backup of the ZENworks Server (this only needs to be done one time). For 
instructions, see “Backing Up a ZENworks Server”in the ZENworks 11 SP3 Disaster Recovery 
Reference.

 Take a reliable backup of the Certificate Authority. For instructions, see “Backing Up the 
Certificate Authority”in the ZENworks 11 SP3 Disaster Recovery Reference.

17.5 Customizing ZENworks Control Center
ZENworks Control Center provides a configuration file that you can use to customize how it functions. 
For example, you can change the default timeout from 30 minutes to another value.

For instructions, see “Customizing ZENworks Control Center” in the ZENworks 11 SP3 ZENworks 
Control Center Reference.

17.6 Tasks for VMware ESX 
 For optimal performance of the Primary Servers running on VMware ESX, set the reserved 

memory size to the size of the guest operating system memory. For more information, see TID 
7005382 in Novell Support Knowledgebase (http://support.novell.com/search/kb_index.jsp).

 In addition, if the ZENworks 11 SP3 guest operating system supports VMware ESX, enable 
additional Java commands to set large pages, as follows:

-XX:+UseLargePages

For more information on memory reservation and large memory pages, see Java in Virtual 
Machines on VMware ESX: Best Practices (http://www.vmware.com/files/pdf/
Java_in_Virtual_Machines_on_ESX-FINAL-Jan-15-2009.pdf).

 Finally, you need to perform the following tasks:

1 Create a backup, then open /etc/init.d/novell-zenserver.

2 In the CATALINA_OPTS string, add the appropriate options, separated by spaces, before the -
XX:PermSize option.

CATALINA_OPTS is used to configure the Tomcat container options. For more information on 
Tomcat, see the Tomcat online documentation.

3 To start the Novell ZENworks Server services, run the following command:

/etc/init.d/novell-zenserver start 

4 To stop the Novell ZENworks Server services, run the following command:

/etc/init.d/novell-zenserver stop

NOTE: If the Novell ZENworks Server fails to start, there is a compatibility problem with the newly 
added option, or the syntax is incorrect. To troubleshoot the service startup, run the following 
command:

/etc/init.d/novell-zenserver debug 

The following log file is displayed:

/opt/novell/zenworks/share/tomcat/logs/catalina.out
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IV IVAppendixes

The following section provide information related to installing the ZENworks Primary Server software: 

 Appendix A, “Installation Executable Arguments,” on page 107

 Appendix B, “Dependent Linux RPM Packages,” on page 109

 Appendix C, “Oracle Enterprise with Partitioning,” on page 117

 Appendix D, “Installation Troubleshooting,” on page 119

 Appendix E, “Documentation Updates,” on page 127
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A AInstallation Executable Arguments

To install Novell ZENworks 11 SP3, the following arguments can be used with the setup.exe and 
setup.sh executable files that are located at the root of the installation DVD. You can run these files 
from a command line.

You should use the sh command with setup.sh in order to prevent rights issues.

Some examples:

 To perform a command line installation on a Linux server:

sh unzip_location/Disk1/setup.sh -e

 To specify a database directory:

unzip_location\disk1\setup.exe -l d:\databases\sybase

 To create a response file:

unzip_location\disk1\setup.exe -s

 To perform an unattended installation:

unzip_location\disk1\setup.exe -s -f c:\temp\myinstall_1.properties

For more information, see Section 9.2, “Performing an Unattended Installation,” on page 46.

Argument Long Form Explanation

-e --console (Linux only) Forces a command line installation.

-l --database-location Specifies a custom OEM (embedded) database directory.

-c --create-db Launches a database administration tool.

It cannot be used at the same time as the -o argument.

-s --silent If this is not used with the -f argument, it causes the installation 
that you are performing to create a response file (with a 
.properties file name extension) that you can edit, rename, 
and use for an unattended installation to another server.

If this is used with the -f argument, an unattended installation on 
the server is started, using the response file that you specify with 
the -f argument.

-f [path to 
file]

--property-file [path to 
file]

Used with the -s argument, performs an unattended (silent) 
installation using the response file that you specify.

If you do not specify a response file, or if the path or file name is 
incorrect, the default non-silent GUI or command line installation is 
used instead.
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B BDependent Linux RPM Packages

ZENworks installation on a Linux server requires that certain RPM packages are already installed on 
the server. Review the following sections for more information on the RPM packages required on the 
Linux devices:

 Section B.1, “Red Hat Enterprise Linux Server,” on page 109

 Section B.2, “SUSE Linux Enterprise Server,” on page 113

B.1 Red Hat Enterprise Linux Server 
You can use the Red Hat Enterprise Linux installation media to install the packages on the Red Hat 
Enterprise Linux server before starting the ZENworks installation on the server:

RHEL 5.x - 64 bit RHEL 6.x - 64 bit

audit-libs acl

binutils audit-libs

bzip2-libs basesystem

compat-readline43 bash

cpio binutils

cracklib ca-certificates

cracklib-dicts chkconfig

device-mapper ConsoleKit

device-mapper-event ConsoleKit-libs

device-mapper-multipath coreutils

dmraid coreutils-libs

dmraid-events cpio

e2fsprogs cracklib

e2fsprogs-libs cracklib-dicts

ethtool cryptsetup-luks

filesystem cryptsetup-luks-libs

gzip db4

hmaccalc dbus

info dbus-glib

initscripts dbus-libs

iproute device-mapper
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iputils device-mapper-libs

keyutils-libs dmidecode

kpartx eggdbus

krb5-libs ethtool

less expat

libacl filesystem

libattr findutils

libcap freetype

libgcc gamin

libjpeg gawk

libselinux gdbm

libsepol glib2

libstdc++ glibc

libsysfs glibc-common

libX11 glibc.i686

libXau gmp

libXdamage grep

libXdmcp gzip

libXext hal

libXfixes hal-info

libXinerama hal-libs

libXrandr hdparm

libXrender hwdata

libXtst info

logrotate initscripts

lvm2 iproute

MAKEDEV iptables

mcstrans iputils

mingetty jpackage-utils

mkinitrd kbd

module-init-tools kbd-misc

nash keyutils-libs

ncurses krb5-libs

RHEL 5.x - 64 bit RHEL 6.x - 64 bit
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net-tools less

nspr libacl

nss libattr

openssl libblkid

openssl097a libcap

pam libcap-ng

pcre libcom_err

popt libgcc

procps libgcrypt

psmisc libgpg-error

python libidn

readline libjpeg

redhat-release libnih

rsyslog libselinux

setup libsepol

sgpio libstdc++

shadow-utils libudev

sqlite libusb

SysVinit libutempter

tar libuuid

termcap libX11

tzdata ibX11-common

udev libX11.i686

util-linux libXau

xorg-x11-filesystem libXau.i686

libxcb

libxcb.i686

libXdmcp

libXext

libXext.i686

libXi

libXi.i686

libxml2

RHEL 5.x - 64 bit RHEL 6.x - 64 bit
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libXtst

libXtst.i686

MAKEDEV

mingetty

module-init-tools

ncurses

ncurses-base

ncurses-libs

net-tools

nss-softokn-freebl

nss-softokn-freebl.i686

openssl

pam

pciutils-libs

pcre

perl

perl-libs

perl-Module-Pluggable

perl-Pod-Escapes

perl-Pod-Simple

perl-version

pm-utils

polkit

popt

procps

psmisc

redhat-release-server

sed

setup

shadow-utils

sysvinit-tools

tcp_wrappers-libs

tzdata

RHEL 5.x - 64 bit RHEL 6.x - 64 bit
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B.2 SUSE Linux Enterprise Server
You can use the SUSE Linux Enterprise Server installation media to install the packages on the 
SUSE Linux Enterprise Server before starting the ZENworks installation on the server:

udev

upstart

util-linux-ng

zlib

RHEL 5.x - 64 bit RHEL 6.x - 64 bit

SLES 10 SP3 - 64 Bit SLES 11 SP2 and SP3 - 
64 Bit

xinetd xinetd

bash bash

libxml2 libxml2

glibc-32bit glibc-32bit

libjpeg-32bit libjpeg-32bit

zlib-32bit zlib-32bit

libgcc libgcc43-32bit

libstdc++ libstdc++43-32bit

perl perl

coreutils coreutils

fillup fillup

gawk gawk

glibc glibc

grep grep

insserv insserv

pwdutils pwdutils

sed sed

sysvinit sysvinit

diffutils diffutils

logrotate logrotate

perl-base perl-base

tcpd tcpd

libreadline5 libreadline5
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libncurses5 libncurses5

zlib zlib

libglib-2_0-0 libglib-2_0-0

libgmodule-2_0-0 libgmodule-2_0-0

libgthread-2_0-0 libgthread-2_0-0

gdbm gdbm

libdb-4_5 libdb-4_5

coreutils-lang coreutils-lang

info info

libacl libacl

libattr libattr

libselinux1 libselinux1

pam pam

filesystem filesystem

aaa_base aaa_base

libldap-2_4-2 libldap-2_4-2

libnscd libnscd

libopenssl0_9_8 libopenssl0_9_8

libxcrypt libxcrypt

openslp openslp

pam-modules pam-modules

libsepol1 libsepol1

findutils findutils

mono-core mono-core

bzip2 bzip2

cron cron

popt popt

terminfo-base terminfo-base

glib2 glib2

pcre pcre

libbz2-1 libbz2-1

libzio libzio

audit-libs audit-libs

SLES 10 SP3 - 64 Bit SLES 11 SP2 and SP3 - 
64 Bit
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cracklib cracklib

cpio cpio

login login

mingetty mingetty

ncurses-utils ncurses-utils

net-tools net-tools

psmisc psmisc

sles-release sles-release

udev udev

cyrus-sasl cyrus-sasl

permissions permissions

glib2-branding-SLES glib2-branding-SLES

glib2-lang glib2-lang

libgcc43 libgcc43

libstdc++43 libstdc++43

cracklib-dict-full cracklib-dict-full

cpio-lang cpio-lang

sles-release-DVD sles-release-DVD

libvolume_id1 libvolume_id1 (applicable 
only for SLES 11 SP2)

licenses licenses

libavahi-client3 libavahi-client3

libavahi-common3 libavahi-common3

libjpeg libjpeg

xorg-x11-libX11 xorg-x11-libX11

xorg-x11-libXext xorg-x11-libXext

xorg-x11-libXfixes xorg-x11-libXfixes

xorg-x11-libs xorg-x11-libs

dbus-1 dbus-1

xorg-x11-libXau xorg-x11-libXau

xorg-x11-libxcb xorg-x11-libxcb

fontconfig fontconfig

freetype2 freetype2

SLES 10 SP3 - 64 Bit SLES 11 SP2 and SP3 - 
64 Bit
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libexpat1 libexpat1

xorg-x11-libICE xorg-x11-libICE

xorg-x11-libSM xorg-x11-libSM

xorg-x11-libXmu xorg-x11-libXmu

xorg-x11-libXp xorg-x11-libXp

xorg-x11-libXpm xorg-x11-libXpm

xorg-x11-libXprintUtil xorg-x11-libXprintUtil

xorg-x11-libXrender xorg-x11-libXrender

xorg-x11-libXt xorg-x11-libXt

xorg-x11-libXv xorg-x11-libXv

xorg-x11-libfontenc xorg-x11-libfontenc

xorg-x11-libxkbfile xorg-x11-libxkbfile

libuuid1 libuuid1

libsqlite3-0 libsqlite3-0

libgobject-2_0-0 libgobject-2_0-0

rpm rpm

util-linux util-linux

libblkid1 libblkid1

util-linux-lang util-linux-lang

update-alternatives update-alternatives

postfix postfix

netcfg netcfg

openldap2-client openldap2-client

lsb-release

SLES 10 SP3 - 64 Bit SLES 11 SP2 and SP3 - 
64 Bit
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C COracle Enterprise with Partitioning

If you are using Oracle Enterprise with partitioning, you need to verify whether the Oracle partition 
feature is enabled with the required license.

Execute the following:

Select Value from v$option where parameter='Partitioning';

The query output value is displayed as "TRUE". This indicates that the partition is enabled. ZENworks 
will automatically run the partition table scripts.
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D DInstallation Troubleshooting

The following sections provide solutions to the problems you might encounter while installing or 
uninstalling Novell ZENworks 11 SP3:

 Section D.1, “Troubleshooting Installation,” on page 119

 Section D.2, “Post Installation Troubleshooting,” on page 125

D.1 Troubleshooting Installation
This section provides solutions to problems you might encounter when installing ZENworks 11 SP3.

 “Installing from the root directory on a Linux device fails to create the self-signed certificates” on 
page 119

 “Configuring the ZENworks Server to an Oracle database fails” on page 120

 “Unable to establish a remote desktop session with a Windows device running the ZENworks 11 
SP3 Configuration Management installation program” on page 120

 “Installing a second server gives an error message” on page 120

 “Installation on Linux fails” on page 121

 “Configure Action fails because of an error detected by HotSpot Virtual Machine” on page 121

 “Unable to install NetIdentity from Novell Client 32 on a device that has ZENworks installed” on 
page 121

 “ZENworks 11 SP3 Configuration Management Installation fails if you choose to configure 
ZENworks Server with the external Sybase database” on page 122

 “Unable to open the ZENworks 11 SP3 Configuration Management Installation logs by using a 
web browser on a non-English Primary Server” on page 122

 “Unable to install .NET 3.5 SP1 on Windows Server 2008” on page 123

 “Unable to install the ZENworks Adaptive Agent on a McAfee fully protected device” on page 123

 “ZENworks-related files might be reported as malicious software during the ZENworks Adaptive 
Agent installation” on page 124

 “Installation of ZENworks Adaptive Agent on a Terminal Server hangs” on page 124

 “ZENworks 11 SP3 installation on an RHEL device might fail” on page 124

 “On Windows XP, installing the ZENworks Adaptive Agent with the Remote Management 
component through Remote Desktop Connection hangs” on page 125

 “ZENworks installation fails on a Linux server” on page 125

 “ZENworks installation does not proceed while using Microsoft SQL named instance” on 
page 125

Installing from the root directory on a Linux device fails to create the 
self-signed certificates

Source: ZENworks 11 SP3; Installation.
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Action: On the Linux device, download and copy the ZENworks 11 SP3 installation ISO 
image to a temporary location to which all users have the Read and Execute 
permissions.

Configuring the ZENworks Server to an Oracle database fails

Source: ZENworks 11 SP3; Installation.

Explanation: If the NLS_CHARACTERSET parameter is not set to AL32UTF8 and the 
NLS_NCHAR_CHARACTERSET parameter is not set to AL16UTF16, the 
database installation fails with the following error messages:

Failed to run the sql script: localization-updater.sql,
message:Failed to execute the SQL command: insert into
zLocalizedMessage(messageid,lang,messagestr)
values('POLICYHANDLERS.EPE.INVALID_VALUE_FORMAT','fr','La 
stratÃ©gie {0} n''a
pas pu Ãªtre appliquÃ©e du fait que la valeur de la variable "{1}" 
n''est pas
dans un format valide.'),
message:ORA-00600: internal error code, arguments: [ktfbbsearch-
7], [8], [],
[], [], [], [], []

Action: Set the NLS_CHARACTERSET parameter to AL32UTF8 and the 
NLS_NCHAR_CHARACTERSET parameter to AL16UTF16. 

To ensure that the character set parameters are configured with the 
recommended values, run the following query at the database prompt:

select parameter, value from nls_database_parameters where 
parameter like '%CHARACTERSET%';

Unable to establish a remote desktop session with a Windows 
device running the ZENworks 11 SP3 Configuration Management 
installation program

Source: ZENworks 11 SP3; Installation.

Explanation: If you try to use a Remote Desktop Connection to connect to a Windows server 
on which the ZENworks 11 SP3 Configuration Management installation program 
is running, the session terminates with the following error message:

The RDP protocol component "DATA ENCRYPTION" detected an error in 
the protocol stream and has disconnected the client. 

Action: See the Microsoft Help and Support web site (http://support.microsoft.com/kb/
323497).

Installing a second server gives an error message

Source: ZENworks 11 SP3; Installation.

Explanation: When you are installing the second server into a Management Zone, an error 
message might be displayed at the end of the installation that contains the 
following text:

... FatalInstallException Name is null

However, the installation otherwise seems to complete successfully.
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This error is being displayed erroneously because the program thinks that the 
server needs to be reconfigured.

Action:  Review the installation log file. If there are no errors there related to this error 
message, you can ignore it.

Installation on Linux fails

Source: ZENworks 11 SP3; Installation.

Possible Cause: If the directory path to which you have extracted the ZENworks 11 SP3 
installation ISO image contains spaces, the installation fails on Linux.

Action: Ensure that the directory path to which you want to extract the installation ISO 
image does not contain spaces.

Configure Action fails because of an error detected by HotSpot 
Virtual Machine

Source: ZENworks 11 SP3; Installation.

Explanation: If you are installing the first Primary Server on a Linux device, and if at the end of 
the process that configures the database you see an error has occurred and you 
are given the option of continuing or rolling back, you should check the log file at 
/var/opt/novell/log/zenworks/ZENworks_Install_[date].log.xml. If you 
see the error specified below, it is safe to continue with the install. 

ConfigureAction failed!:

select tableName, internalName, defaultValue from Adf where inUse 
=?#
An unexpected error has been detected by HotSpot Virtual Machine:
#SIGSEGV (0xb) at pc=0xb7f6e340, pid=11887, tid=2284317600
#
#Java VM: Java HotSpot(TM) Server VM (1.5.0_11-b03 mixed mode)

#Problematic frame:
#C [libpthread.so.0+0x7340] __pthread_mutex_lock+0x20

Action: Ignore the error message.

Unable to install NetIdentity from Novell Client 32 on a device that 
has ZENworks installed

Source: ZENworks 11 SP3; Installation.

Explanation: When you try to install the NetIdentity agent that ships with Novell Client32 on a 
device that has ZENworks 11 SP3 installed, the installation fails with the 
following error message:

An incompatible version of Novell ZENworks Desktop Management 
Agent has been detected

Possible Cause: The NetIdentity agent is not installed before installing ZENworks.

Action: Do the following:

1 Uninstall ZENworks 11 SP3.

For more information, see ZENworks 11 SP3 Uninstall Guide. 

2 Install the NetIdentity agent from Novell Client32.
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3 Install ZENworks 11 SP3.

For more information, see Chapter 9, “Installing a ZENworks Primary Server 
on Windows,” on page 45.

ZENworks 11 SP3 Configuration Management Installation fails if you 
choose to configure ZENworks Server with the external Sybase 
database

Source: ZENworks 11 SP3; Installation.

Explanation: During the ZENworks 11 SP3 installation, if you choose to configure the 
ZENworks Server with either the Remote OEM Sybase or Remote Sybase SQL 
Anywhere database, the installation fails and the following message is logged in 
the Installation logs:

Caused by: 
com.mchange.v2.resourcepool.CannotAcquireResourceException: A 
ResourcePool could not acquire a resource from its primary factory 
or source.

Possible Cause: The specified external database server name is incorrect. 

Action: Relaunch the ZENworks 11 SP3 Configuration Management Installation Wizard 
and ensure that you specify the correct external database server details. 

Unable to open the ZENworks 11 SP3 Configuration Management 
Installation logs by using a web browser on a non-English Primary 
Server

Source: ZENworks 11 SP3; Installation.

Explanation: On a non-English Primary Server that has ZENworks 11 SP3 Configuration 
Management installed, you are unable to open the Installation logs by using a 
web browser. However, you can still open the Installation logs in a text editor.   

The Installation logs are located at /var/opt/novell/log/zenworks/ on Linux 
and zenworks_installation_directory\novell\zenworks\logs on 
Windows.

Action: Before opening the Installation logs (.xml) in a web browser, change the 
encoding for all the Installation LogViewer files:

1 Using a text editor, open one of the following LogViewer files located at /
var/opt/novell/log/zenworks/logviewer on Linux and 
zenworks_installation_directory\novell\zenworks\logs\logviewr 
on Windows:   

 message.xsl 

 sarissa.js 

 zenworks_log.html

 zenworks_log.js

 zenworks_log.xsl

 zenworks_log_text.xsl

2 Click File > Save As. 
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The Save As dialog box is displayed. 

3 In the Encoding list, select UTF-8, then click Save.

Do not change the filename and file type. 

4 Repeat Step 1 through Step 3 for the remaining LogViewer files. 

Unable to install .NET 3.5 SP1 on Windows Server 2008

Source: ZENworks 11 SP3; Installation.

Explanation: The installation of Microsoft .NET 3.5 SP1 on Windows Server 2008 fails with the 
following error message:

Microsoft .NET Framework 2.0SP1 (x64) (CBS): [2] Error: 
Installation failed for component Microsoft .NET Framework 2.0SP1 
(x64) (CBS). MSI returned error code 1058

Possible Cause: The device does not have the Windows Update Service enabled.

Action: Enable the Windows Update service on the device:

1 From the Windows desktop Start menu, click Settings > Control Panel.

2 Double-click Administrative Tools > Services.

3 Double-click Windows Update Service. 

The Windows Update Service Properties dialog box is displayed. 

4 In the General tab, select one of the following options from the Startup type 
list:

 Manual

 Automatic

 Automatic (Delayed Start)

5 Click Start to start the service. 

6 Click OK. 

Unable to install the ZENworks Adaptive Agent on a McAfee fully 
protected device

Source: ZENworks 11 SP3; Installation

Explanation: When you try to install ZENworks Adaptive Agent on a McAfee fully protected 
device, the antivirus software prevents the creation of new executable files in 
Windows and program files.

Possible Cause: The device is protected by McAfee VirusScan and therefore does not allow the 
installation of any applications.

Action: Do the following on the device that has the McAfee software installed:

1 Click Start > All Programs > McAfee > VirusScan Console.

2 Double-click  Access Protection.

3 In the Access Protection Properties dialog box, do the following:

3a In the Categories panel, click Common Maximum Protection.

3b In the Block column, deselect all the rules.

3c Click OK.
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4 Install the ZENworks Adaptive Agent.

For more information, see “ZENworks Adaptive Agent Deployment” in the 
ZENworks 11 SP3 Discovery, Deployment, and Retirement Reference.

ZENworks-related files might be reported as malicious software 
during the ZENworks Adaptive Agent installation

Source: ZENworks 11 SP3; Installation.

Explanation: During the ZENworks Adaptive Agent installation, some ZENworks-related files 
might be reported as malicious software by anti-virus software. Consequently, 
the installation abruptly stops.

Action: Do the following on the managed device where you want to install the ZENworks 
Adaptive Agent:

1 Manually add System_drive:\windows\novell\zenworks to the 
Exclusion list of the anti-virus software installed on the managed device.

2 Install the ZENworks Adaptive Agent.

Installation of ZENworks Adaptive Agent on a Terminal Server hangs 

Source: ZENworks 11 SP3; Installation

Possible Cause: Installation of ZENworks Adaptive Agent on a Terminal Server hangs because 
the default mode in the Terminal Server is Execute.

Action: Change the mode in the Terminal Server to Install:

1 From the Command Prompt:

1a To change the mode, execute the following command:

change user /install

1b Type exit, then press ENTER.

2 Install the ZENworks Adaptive Agent.

For more information, see “ZENworks Adaptive Agent Deployment” in the 
ZENworks 11 SP3 Discovery, Deployment, and Retirement Reference.

ZENworks 11 SP3 installation on an RHEL device might fail 

Source: ZENworks 11 SP3

Explanation: ZENworks 11 SP3 installation on an RHEL device might fail and prompt you to 
roll back. The following message is reported in the install log file:

RPM returned 1: warning: /opt/novell/zenworks/install/downloads/
rpm/novell-zenworks-jre-links-1.7.0_3-1.noarch.rpm: Header V3 DSA 
signature: NOKEY, key ID 7e2e3b05

Failed dependencies: jre >= 1.7 is needed by novell-zenworks-jre-
links-1.7.0_3-1.noarch 

Action: Perform the following tasks:

1 Roll back the ZENworks 11 SP3 installation.

2 Manually install JRE by running the following command at the terminal:
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rpm -ivh <BUILD_ROOT>/Common/rpm/jre-<VERSION>.rpm 

3 Install ZENworks 11 SP3. For more information, see “Installing the Primary 
Server Software” on page 45. 

On Windows XP, installing the ZENworks Adaptive Agent with the 
Remote Management component through Remote Desktop 
Connection hangs

Source: ZENworks 11 SP3; Installation

Explanation: If you remotely connect to a managed device by using Remote Desktop 
Connection (RDP) and install ZENworks Adaptive Agent, the installation hangs.

Action: To fix the issue, download the patch from the Microsoft Support web site (http://
support.microsoft.com/kb/952132) and install it on the managed device prior to 
installing the ZENworks Adaptive Agent.

ZENworks installation fails on a Linux server 

Source: ZENworks 11 SP3; Installation.

Explanation: ZENworks installation on a Linux server requires that certain RPM packages are 
already installed on the server.

Action: Install the required RPM packages on the Linux server. 

ZENworks installation does not proceed while using Microsoft SQL 
named instance

Source: ZENworks 11 SP3; Installation.

Explanation: While using named instance for Microsoft SQL, the install wizard will not proceed 
even after providing the correct information in the database panel. This occurs if 
Checksum offloading is enabled on the NIC card of the machine. 

Action: Ensure that Checksum offloading is disabled on the NIC card. For more 
information, refer to the applicable manuals for SLES, RHEL, or VMware.

D.2 Post Installation Troubleshooting
This section provides solutions to problems you might encounter after installing ZENworks 11 SP3.

 “Unable to access ZENworks Control Center on a ZENworks Primary Server running on SLES” 
on page 125

 “Auto Launch ZENworks Control Center configuration does not work in SLES 11 SP3 machine” 
on page 126

Unable to access ZENworks Control Center on a ZENworks Primary 
Server running on SLES

Source: ZENworks 11 SP3; Installation.
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Explanation: During the installation of ZENworks Server on a SLES device, if you have 
specified the port as 8080, the installation is successful. However, you might not 
be able to access the ZENworks Control Center. 

Action: Perform the following steps on the SLES device on which you have installed the 
ZENworks Server:

1 Start YaST.

2 Click Firewall.

3 In the Firewall Configuration Window, click Allowed Services.

4 Click Advanced.

5 In the Additional Allowed Ports dialog box, replace http-alt in the TCP Ports 
and UDP Ports options with 8080, then complete the Wizard.

Auto Launch ZENworks Control Center configuration does not work 
in SLES 11 SP3 machine

Source: ZENworks 11 SP3; Installation.

Explanation: In the Post installation configuration, if the Auto launch ZCC option is selected, 
after installation, ZENworks Control Center does not launch automatically in 
SLES 11 SP3 machines.

Action: Manually launch ZENworks Control Center. 
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E EDocumentation Updates

This section summarizes the significant changes made to the Server Installation Guide since the 
initial release of ZENworks 11 SP3.

July 2014: System Update (11.3.1) for ZENworks 11 SP3

Location Change

Rights to Create the Database Added an important note to explain what the Oracle database rights 
are used for during installation or upgrade of a Windows Primary 
Server and how long they are required.
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